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Learning Objective

Learning objectives

As we know computer is a tool by which we can get various details about the things required
in our daily life.

This book has been prepared for the student who doesn't have basic knowledge about
computer.

e Awareness about internal and external components and their usage.

e Use of computers in various fields (education, entertainment, environment, securities etc)
e To prepare documents, home budgets, future plans through the computer.

e Storage of the document for a long period.

e Internal working system of computer number system.




CHAPTER 1 COMPUTER : AN INTRODUCTION
AND EVOLUTION

INTRODUCTION

Today, computers are being used in each and every field of life. They have become an important part of our day-

to-day activities. Itis used in various organizations like railways, airlines, banks, universities, hospitals etc.

WHAT ISACOMPUTER?

A computer is an electronic device, which accepts data and instructions as input, processes and stores the

data, and gives the result as output.

Computer can access and process data millions of times faster than human beings. Computer can do a lot of
different task such as playing games, railway reservation, weather forecasting, error detection and controlling

the flight space aircraft etc.
A computer is used as a data processor. The terms data and information are very commonly used.

Data: Data in computer terminology mean raw facts and figures. For example 'Sumit','1983','A", 165.39, and

68.2 are data. Data are processed to form information.

Information: Organized collection of data is known as information. It means what we get after processing data

(meaningful data). For example “SUMIT” whose roll number is 1983 has got grade 'A ' is information.

COMPUTER SYSTEM

Output Device (Monitor)

CPU (Central Processing Unit)

A computer system consists of a group of electronic
devices used to perform a variety of operations. This group

of'devices can be divided into three basic units.

The three basic units forming a computer system are:
1. INPUTUNIT
2. CENTRALPROCESSING UNIT
3. OUTPUTUNIT

-
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Speaker Keyboard Mouse

Fig 1.1 A
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Some major application of computers

1.  Business

2.  Medicine and health care

3.  Communication

4.  Education

5. Science, Research and engineering
6. Law enforcementby police
7.  Music

8. Military

9.  Government

10. Theatre, film and Television
11. Computers athome

12. Manufacturing

EVOLUTION OF COMPUTER
Introdution -

In older days it was difficult for big calculation. Earlier human was calculated by piece of stone and draw line on
the wall. Decimal number system was developed. Development was on the basis of the whole number. The
calculator and computer invented for calculation in development process.

Fig 1.1 Older days medium of calculation

ABACUS- dplyl |
Many centuries ago when started to count the number, he P .
thought of a device which can trace the numbers and thus I l I I I l l 3 I l ! l l l
came the existence of ABACUS. Abacus was the first n S

calculating device. It developed in China about 3000 years
ago. It was made of wooden frame with columns of wire

()

Fig 1.2 A Abacus



Earth. It is used for calculation and counting purpose with ‘
the help of beads. % z/

having beads on them. Wooden frame is divided into two *‘ ' !
parts. First part is called Heaven. Second Part is called eoves Wipere 4 AN .
S000000———01

Fig 1.2 B Abacus

PASCALINE -

A French mathematician Blaise Pascal made first
mechanical calculator Pascaline in 1642. The
other name of this machine is Adding machine.
This machine can do addition and subtraction.
This machine based on watch and Odometer.

Fig (1.3) Blaise Pascal ~ Fig (1.4) Pascaline or Adding machine

DIFFERENCE ENGINE -

English Mathematician Charles Babbage developed first
automatic calculating machine in 1822. This machine
called Difference Engine.

Fig (1.5) Difference Engine

ANALYTICAL ENGINE -

English Mathematician Charles Babbage made
Analytical Engine in 1833. This was a revised and
advance form of Difference Engine. This machine was
similar to modern age computer. Charles Babbage has
greatly contributed to the development of Computer. So
Charles Babbage is called Father of Computer.

Sha )T

Fig (1.6) Analytical Engine Fig (1.7) Charles Babbage

LADY ADA AUGUSTA -

Lady Ada Augusta stored instruction in Analytical Engine.
So she called first programmer in the world.

Fig 1.8 Ada Augusta

(o)



N ‘ | ﬁ‘\ HOLLERITH CENSUS TABULATOR -
: b et il |- . Dr. Harman Hollerith made a calculating
DHC000006T | ¢ b‘ ‘ device. The name of this device is Census
My :VV : s tabulator Punched Cards is used to

: : <V represent data in this machine.
‘ This machine run by electricity. US
i A_ 4. censushad completed in three year with the

Fig (1.9) Census Tabulator Fig (1.10) Harman Hollerith help of this machine.

AIKEN AND MARK-I-

Scientist Howard Aiken and top four engineers Of IBM
(International Business Machine) developed a machine
in 1939. The name of this machine was Mark 1. Mark I
was first Electro mechanical Computer in the World.

3
¥
®
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This computer can do multiply in 6 second and division
in 12 second.

Fig (1.11) Howard Aiken with Mark I

ENIAC -

Electrical engineer Sir J.P. Ecort and John Mitchell made a
computer in 1946. The name of this computer is ENIAC
(Electronic Integrator and calculator). ENIAC was first electronic
computer in the world.

C COMPUTER GENERATION)

Generation in computer terminology is a change in technology a computer is being used. There are five
computer generations known till date. Following are the main five generations of computers -

1- First Generation -

The period of first generation was 1946-1958. Computers of first generation used Vacuum tubes. Computers
used Magnetic Drum for memory. These computers were very big.

(oe)



The main features -

Main computers.

Vacuum tube technology
Supported machine language only
Very costly

Generated lot of heat

Slow input and output devices
Very big size

Consumed lot of electricity

Fig (1.13) Vacuum Tube
ENIAC

EDVAC
UNIVAC

Fig (1.14) First Generation Computer

2- Second Generation -

The period of second generation was 1959-1965. Computers of second generation used transistor. Transistors
were cheaper, consumed less power, more compact in size. Computers were faster than the first generation
machines made of vacuum tubes.

The main features -

Main computers.

Transistors technology.

Magnetic cores were used as primary memory.
Magnetic tape and magnetic disks were used as
secondary storage devices.

Assembly language and high-level programming
languages like FORTRAN, COBOL were used.
The computers used batch processing and
multiprogramming operating system.

IBM 1620
IBM 7094
CDC 1604
CDC 3600
UNIVAC 1108

Fig (1.17) Second Generation Computer
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3- Third Generation -
The period of third generation was 1965-1971. Computers of third generation used IC (integrated circuits)

inplace of transistors. The IC was invented by jack Kilby.

The main features -

ICused

Smaller size

Generated less heat

Faster

Still costly

Supported high-level language like Basic

Main computers.

IBM-360 series
Honey well-6000 series
PDP (Personal Data Processor)

4- Fourth Generation -

The period of fourth generation was 1971-1980. The computers of fourth generation used VLSI (Very
Large Scale Integrated) circuits. VLSI circuits having about 5000 transistors and other circuit elements and
their associated circuits on a single chip. So it is called Microprocessor.

The main features -

Main computers.

VLSItechnology used
Very cheap

Portable and Reliable
Very small size
Pipeline processing

Concept of internet was introduced

DEC10
STAR 1000
CRAY-1 (Super Computer)

(oo)

Fig (1.20) Third Generation Computer

Fig (1.22) Fourth Generation Computer



5- Fifth Generation -

The period of fifth generation was 1980-till date. The Computer of fifth generation used ULSI (Ultra Large
Scale Integration) technology. This generation is based on parallel processing hardware and Al (Artificial
Intelligence) software.

The main features -

e ULSItechnology

e Development of true artificial intelligence

e Development of Natural language processing Fig (123) UL.S1
1g (1. .LS.L.

e  Verycheap.

e  More user friendly interfaces with multimedia features
e verypowerful

e Roboties

e Neural networks

e GamePlaying

Main computers.
e  Desktop
e Laptop
e Note Book
e UltraBook Fig (1.24) Fifth Generation Computer

e Chorme Book

Types of Computer
Computer depending on the purpose, work and size of various types.

Types of computers based on size

Computer can be four types based on size -
1. Micro Computer
i1. Mini Computer
iii. Mainframe Computer
iv. Super Computer

i.  Micro Computer -

The development of computer is started from 1946. The microprocessor was invented in 1970.
Microprocessor was developed by Intel. The name of first microprocessor was Intel 4004. Microprocessor used
in computer. This computer is called Micro computer.

(o)



These are based on the microprocessor technology. These are the smallest size of computer. The computer
can be placed on a desk or briefcase. These are used for personal use in school, home or office. So they are called
PC (Personal computer).

Fig (1.25) Micro Computer

ii.  Mini Computer -

These are mid size computer. Mini computer has more work capacity than Micro computer. Mini
computers are costly than micro computers. Mini computers are used in banks, share market, server etc. Multiple
users can work on Mini computer. Mini computer has more than one CPU. PDP-8 was the first Mini computer.
Size of PDP-8 was as Refrigerator.

Fig (1.26) Mini Computer

iili. Mainframe Computer -

Mainframe computer is very large in size. Mainframe computer has very large storage capacity.
Mainframe computer executes many programs in one time. Mainframe computers are used in companies, share
market or Government as server computer. Multiple users can work on Mainframe computer. IBM 4381, ICL 39
are example of Mainframe computer.

Fig (1.27) Mainframe Computer
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iv. Super Computer -

Super computer have most speed and very large storage capacity in all categories of computers. They work
in order to parallel multiple CPU. These computers are very costly. Super computers are used in weather
forecasting, scientific simulations, animated graphics, nuclear energy research etc. Param 8000 is a first Indian
Super computer. Param 10000 is a very popular India Super computer. Cray 2 and NEC is another example of
Super computer.

Fig (1.28) Super Computer

Exercise
1. Choose theright answer :

a. Whatis computer ?

(1) Electronicdevice (ii) Inputdevice (111) Storagedevice (iv) None ofthese
b. Which device developed in China ?

(1) Digital computer (i1)) Abacus (111) Pascaline (iv) MarklI
c. The period of First Generation was -

(1) 1956-1958 (i) 1935-1944 (ii1) 1988-2000 (iv) None ofthese
d. Who invented IC?

(1) JackKilby (1) LadyAdaAugusta (iii)) Raman (iv) Charles Babbage
e. The name of first Microprocessor was -

(1) Intel4005 (i) Intel4004 (ii1) Intel4002 (iv) Intel2005

2. Fill in the blanks.

was first automatic calculating device.

is called father of computer Science.

Abacusis developedin

English Mathematician Charles Babbage made

is called first programmer in world.

The computers of first generation used

N

The computers of second generation used inplace of

(o)



h. Param 10000 is a Super computer.

1. The size of mini computer PDP-8 was as

] are based on the microprocessor technology.

3. Write true or false -

The size of first generation computer is equal to the mobile phone.

The capacity of fourth generation computer is greater than third generation computer.
The computers of second generation used VLIC

Micro computer has more than one CPU.

The size of first Super computer was near about 90 square feet room.

Abacus was the first Calculating Device in the World.

Difference Engine was Invented in 1642.

B oo a0 oo

A French mathematician Blaise Pascal made Pascaline.

—

Eniac was made by Engineer of IBM.
Microprocessor was invented in 1970.

—.

4. Match the following.

a. First Generation VLSI
b. Third Generation Vacuum Tube
C. Fourth Generation IBM 1620
d. Micro Computer IC
e. Second Generation PC
f. Microprocessor 1833
g. Analytical Engine Micro Computer
h. Mark I Eniac
1. JPEcort 3000 Years
J. Abacus 1939
S. Give answer of the following questions -
a. What is Computer ?
b. When was microprocessor invented ?
c. When was Mark [ made ?
d. Who was first programmer in the world ?
e. Who s called father of computer Science ?
f. How many types of generations of the computers ?
g. Write the difference between second Generation and third Generation.
h. What is the main features of First Generation ?
1. Write the definition of Micro computer.
J- What is computers used for memory in First Generation ?

(o)



CHAPTER 2

COMPUTER SYSTEM ORGANIZATION

Input Device

4 )
o Main Memory
A
\ 4
Control Unit (CU)
A
\ 4
Arithmetic Logic Unit
(ALU)
- J
Fig 2.1

BLOCK DIAGRAM OF COMPUTER SYSTEM

Functional units of computer system

Output Device

1. Inputunit: The input unit consists of input devices. These are the devices that are used to input data into
a computer. Keyboard and mouse are the most common input devices. Scanner, Joystick, Light pen,
OCR, MICR, Digital camera etc. are other examples of input devices.

2. Output unit: This unit consists of the devices that are used to give the output i.e. the processed
information to the user. Such devices are known as output devices. Monitor and printer are the most
commonly used output devices.

3. Central Processing Unit: Central Processing Unit, commonly known as CPU, is the most important
unit, where all the processing jobs take place. CPU is the control centre of the computer and hence it is
said to be the "brain" of the computer.

Main Components of CPU

1. Arithmetic and Logic Unit

2. Control Unit
3. Memory Unit

()



Arithmetic and Logic Unit (ALU)

This part of CPU performs all the arithmetic operations like addition (+), multiplication (*), subtraction (-),
division (/). It is also performing logical decisions like comparing two numbers whether they are equal or not. It
can also compare alphabetic data to check whether they are same or not. So all the logical operations like less

than (<), greater than (>), equal to (=), not equal to () etc, are also carried out by the ALU.

ALU perform all arithmetic and logical operations.

CONTROLUNIT (CU)

This device controls all the operations taking place in the system. It controls the flow of data and information
from one unit to other.
Specially, CPU perform the following functions

Direct the flow of data and instructions from input device to memory.
Direct the data and instructions from memory to ALU as and when required by the program.
Transfer the information/processed data from ALU to memory.

b=

Transfer the information/processed data from memory to output unit

CU (Control Unit) control and co-ordinates all operations taking placein the system.

MEMORY UNIT

To execute a program, data and instructions need to be stored temporarily. This storage is done in the memory
unitof CPU.

The data and instructions are retrieved from the memory unit by the control unit for supplying to ALU as and
when required by the program.

MU (Memory Unit) provides temporary storage for data and instructions.

MEMORY IN COMPUTER SYSTEM

In a computer system memory is required to store the data and instructions entered from input device, as well as
result of processing given by the CPU. Memory divided into two parts.

1.  Primary Memory

2. Secondary Memory

(1)



Computer Memory

Primary Memory or Temporary Secondary Memory or Auxillary
Memory Memory
RAM ROM
PROM EPROM
Floppy Disk Hard Disk Magnetic Tape Compact Disk

Memory is an important component required to store data and instructions. A computer system has
two types of memory i.e. Primary Memory, Secondary Memory.

PRIMARY MEMORY

Primary memory is the internal memory that can be directly accessed by the control unit of CPU. It provides
temporary storage for data and instructions being processed and information produced by ALU. The primary
memory is of two types.

1. RAM (Random Access Memory)

' It is volatile memory and allow
Hvﬁa (™ read and write operations. The
: data stored in this memory get lost

when computer is switched off.

Kingston I=
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2. ROM (Read Only Memory)
ROM is non-volatile memory and allows read operations only.

TYPES OF ROM
There are many types of ROM like PROM, EPROM etc.

PROM (Programmable Read Only Memory)

In PROM the information is stored by programmer once after its manufacturing. It can't be altered or erased later
on.

EPROM (Erasable Programmable Read Only Memory)

It is similar to the PROM but its information can be erased later on by ultra violet light and it can be re-
programmed.

CACHE MEMORY
It is a small high-speed memory, which is used to increase the speed of processing by sending current programs
and data to the CPU.

SECONDARY MEMORY

Secondary memory is used to store large amount of data and information permanently. This memory is also
known as External memory or Auxiliary memory. Some secondary memories are Floppy disk, CD-ROM, and
Hard disk etc.

HARD DISK

A hard disk is a permanent storage device that can
store large amount of data. It consists of circular
metallic disks coated with a magnetic material on
both sides of disk. Data is read or written to hard
disk with the help of read/write heads.




DVD(DIGITAL VERSATILE-DISK)

Fig 2.5

STORAGE UNITS

Memory units
1 Nibble
1 B (Byte)
1 KB (Kilo Byte)
1 MB (Mega Byte)
1 GB (Giga Byte)
1PB (Peta Byte)
1XB (ExaByte)
1ZB (zolta Byte)

INPUTDEVICES

DVD-ROM is used to store digital data
permanently. The surface ofa DVD is covered with
atransparent plastic coat.

Data is stored on a DVD-ROM in the forms of tiny
pits that are burned out with the help of laser beam
into a thin coating on its surface. To read the data
from a DVD, a DVD-ROM drive is needed which
uses a laser beam to read the data on the DVD.
Storage capacity of DVD-ROM stores 4.7 GB of
data.

Equivalent Unit
4 bits
8 bits
1024 Bytes
1024KB
1024 MB
1024GB
1024PB
1024XB

Input devices is used to input data from the user, some commonly used input devices are discussed below:

KEYBOARD

Keyboard has many keys, which are used to
enter the data into the computer. A keyboard
contains the following different types of
keys.

e Alphabetickeys - A-Z
e Numerickeys - 0-9
e Functionkeys - FI-F12

+

Shift, Alt, Ctrl etc.

e Arrowkeys

e Special keys

15



MOUSE

A mouse has two or three buttons. The left button
activates any program by clicking its icon and right
button opens a shortcut menu of commands.

Fig 2.7
SCANNER

A scanner works like a Xerox machine using laser
beams and display the scanned image on the monitor.
The scanned image can be stored in a file to again

access or edit it.

JOYSTICK

A joystick is an input device mainly used for video
games. It sends the signals to the game programs to
enjoy the games by moving the cursor and objects in
them in the desired direction.

Fig 2.9

LIGHT PEN

It is pen like photosensitive instrument and senses a
position on the monitor when it is positioned at screen.

Fig 2.10

(1)



OCR (Optical Character Reader)

This technique is used to read the printed characters directly and convert them into an appropriate code before
storing into the computer. It may be used for validating the examination papers and applications forms. It does
not require any special type of ink for reading but can recognize many different OCR fonts as well as typewriter
and computer printed characters. An advance OCR system can recognize (read) hand made letters and numbers.

MICR (Magnetic Ink Character Reader)

This device is widely used in banks to process a number of cheques written daily. Each cheque has a pre coded
bank number, account number and cheque number at the bottom with the special ink consisting of magnatizable
particles of iron oxide. When a cheque is presented for payment, this same ink is again used by bank to encode
the amount in the lower right corner.

Each cheque is inserted into an MICR reader, which sends the cheque information including the amount of the
cheque to a computer for processing.

OUTPUTDEVICES

Some commonly used output devices are discussed below:

Monitor

A monitor is an essential output device, which is also called a screen, VDU (Visual Display Unit) or CRT
(Cathode Ray Tube). It is just like a T.V. screen that displays the text and graphics on its screen. It displays
everything, which is typed through keyboard and also produces the results of the programs and calculations
performed on computer.

Monitor

Fig 2.11

Printer
This device is used to produce hard copy. Any type of data i.e. text or graphics displaying on the monitor can be
printed on paper by the printer. There are two distinct categories of the printers impact and non-impact printers.

()



Impact Printers

These printers have the mechanical contact between their printer head and paper. The pins available in print head
are physically hit against the ink ribbon and hit characters formed by the dots of pins are printed on the paper.
Such printers are less expensive.

Example. Daisy Wheel Printer (Character Printer), DMP (Dot Matrix Printer), Line Printer

Non-Impact Printers

Not-Impact printers do not have pins and ribbons. They do not also have any mechanical contact between the
print head and paper. These printers use thermal, chemical electrostatic and inkjet technologies and spray the
colors by holes or laser beams. Such printers produce the best quality output.

Examples: Ink-Jet Printers, Laser Printer etc.

Speaker

Itis an output device and gives the output in the form of sound.

Exercise
1. Choose theright answer :

a. Keyboardisa-

(1) Electronicdevice (ii) Inputdevice (ii1)) Outputdevice (iv) None ofthese
b. AlJoystick is used for -

(1) Video games (i1)) Songs (ii1)) Pointing (iv) OCR
c. Aharddiskisa-

(1) Inputdevice (i1)) Storagedevice (ii1)) Outputdevice (iv) None ofthese
d. 1 Nibble -

(i) 6bits (i) 4bits (i) 104 bytes (iv) 8bits
e. Which is a small high speed memory -

(i) Cache memory (i) RAM (iii) ROM (iv) CD

2. Fillin the blanks.

a. A is a group of eight bits.
b. AlLightPenisan device.
c. EPROM stands for Programmable Read Only Memory.
d. A Secondary Memory also called memory
e. An output produce by printer called copy.
f. Aharddiskisa storage device.
g. All the arithmetic and logical operations perform in
h. A computeris an device.

N
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State True or False:

a. Joystick is an output device.
b. Primary memory is also known as temporary memory.
c. Laser printer is an Impact Printer.
d. Light Pen is an Input device.
e. Speaker is a output device,

f. CPU only does calculations.
g. One GB equals to 1024 Bytes.
Write the full form of:

a. VDU

b. ALU

C. MU

d. CuU

e. ROM

f. PROM

g. CPU

h. MICR

1. OCR

J- DVD

k. EPROM

1. PB

m. EB

n. 7B

Answer to the questions given below:

B om0 a0 oo

—

—.

Write down main components of computer system
Differentiate between Input and Output devices.
Explain the different types of Primary Memory.

Differentiate between Primary and Secondary memory.

Explain the function of printer.

Differentiate between Impact and Non-Impact printers.

Explain the working of Light pen.
Differentiate between PROM and EPROM.
Why we use Cache memory?

Draw the Block diagram of the computer system.

()



CHAPTER 3 INTRODUCTION TO COMPUTER
HARDWARE AND SOFTWARE

Hardware: Hardware refers to any physical component of a computer. For example, CPU, Monitor,
Keyboard, Hard Disk, Floppy Disk, etc.

Software: Software refers to the programs, which are required to operate the computer. For example, MS-
DOS (Microsoft Disk Operating System), BASIC, COBOL, dBASE, an accounting software, etc.

Difference between Hardware and Software:
The difference between hardware and software is explained in the following table:

Hardware Software
1. Hardware is physical component of 1. Softwares are instructions given to the
computer. computer.
2. You can touch hardware. 2. You cannot touch software.

3.  Examples: Keyboard, CPU, and Floppy etc.. 3. Examples: Windows, MS WORD etc.
Both hardware and software are dependent on each other. CPU, Memory Unit, Hard Disk, etc. are
useless unless they are provided with instructions and data for storage and processing. Similarly, Windows or
MS WORD has no importance unless they are used along with various hardware components of the computer.

Hardware Components of a Microcomputer (Desktop)

In today's computer industry, a wide variety of hardware components are available for microcomputers. The
hardware components of a microcomputer can be classified into the following types:

Input Devices

Output Devices
Storage Devices
Cards

Ports and Cords
Power Supply

Cabinet

Motherboard and CPU

b IR e

Fig 3.1



Motherboard

Motherboard is the most important hardware component of a microcomputer. Motherboard contains CPU and
other chips of computer system. So, itis also called System Board.

AGP Slot
CMOS Battery Slot

PCI-Slots (x5)
Southbrjd

Northridge
(with heatsink)

Parallel Port
rial Port (2x)

- USB Ports (4x)
CPU Socket PS2 (Mouse + Keyboard)

Heatsink
mounting
points

Fig 3.2

Cards

Cards are the printed circuit boards used to hold the chips (integrated circuits). A common example of card is
sound card that generates the sound ina PC.

Ports and Cards

Besides the important hardware discussed above, the computer has several components, which are used as

pathway for flow of data. The rear of a PC has many empty holes or external sockets called Ports or Connectors.
Cards are the cables used to plug into the ports. There are different types of cables for connecting

different types of input, output and storage devices. The important cards used in a PC are keyboard cards, power

cards, monitor cards and printer cards.

Power Supply
Power supply considered as the 'Heart' of a PC. Power supply is that important hardware, which provides the
power source to a computer. Power supplies vary in size and power (in watt).

Cabinet
All the hardware components of a PC except Input and Output devices are placed inside a metallic box, called a
Cabinet. Many designs of cabinets with different sizes are available for PCs.

()



Types of Software
Software are broadly classified into following two types:

A. System Software
B. Application Software

A.  System Software : Software that is required to control the working of hardware and help in execution
of applications are called System Software. This software performs a variety of functions like file management,
storage management, [/O management, etc. System Software is developed by computer professional called
System Programmers.

Examples: MS DOS (Microsoft Disk Operating System), Windows 95, Windows 98, Windows 2000, UNIX etc.

Computer Languages

A computer language is a set of commands, understandable by computer directly or after translating. A
program s a set of instructions written in a computer language.

System Software includes:
(i) Operating System
(ii) Language Translator (Language Processor)

(i) Operating System : An operating system is the most essential system software that manages the
operation of a computer. Without an operating system, it is not possible to use the computer. An operating system
is software, which makes the computer ready to use by a process called booting.

SWITCH ON THE COMPUTER

AUTOMATIC EXECUTION OF
INSTUCTIONS STORED IN ROM

DISK RAM

LOADING OF OPERATING
SYSTEM
(BOOTING)
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(i)  LanguageTranslators: Regardless of the programming language used (except machine
language), the symbolic instructions have to be executed by computer. The software, which converts the codes
of other languages into machine code, are collectively called Language Translators.
Language Translators are categorized into three types:

(1) Assemblers

(11) Interpreters

(iii)  Compilers
(i) Assemblers : Assemblers translate assembly language code (source program) into machine language
code (object program). The Microsoft assembler program (MASM) and Borland Turbo assembler program
(TASM) are two popular assemblers.

(ii)  Interpreters : Instructions ofahigh level language are coded in many statements. At the time of their
execution they are converted into machine code, statement by statement, by using system software, called
Interpreters.

Example : BASICA or GWBASIC interpreters execute programs written in BASIC language.

(iii) Compilers : In contrast to interpreters, compilers provide faster execution speed. Compilers do not
translate and execute the instructions at the same time. They translate the entire program (source code) into
machine code (object code). Compilers are widely used in translating codes of high level languages e.g.
COBOL, FORTRAN, PASCAL, Turbo/ Quick BASIC, Turbo/Microsoft C etc.

B.  Application Software : Software those are required for general and special purpose applications
like word processing, accounting, etc. are called Application Software. Application software are developed

using system software by computer professionals called Application programmers.
Examples : MS WORD, MS EXCEL and Paint.

Types of Application Software:
Application software are classified into following types:

(a) General Purpose Application Software

(b) Special Purpose Application Software

(©) Utility Software
(a) General Purpose Application Software : Whenever an organization purchases computers,
besides and operating system, certain application software are also required to be purchased. These software are
needed for general purpose like word processing, database management, spreadsheets, etc. Delete are known as
general purpose software.

Examples : Microsoft WORD, Microsoft EXCEL and Microsoft ACESS.

(b)  Special Purpose Application Software : Besides general purpose application software, some
organizations also need software for special applications such as Desktop Publishing (DTP), graphics,
multimedia, animations, financial accounting, sales and marketing, inventory, export documentation, etc. These
softwares are collectively known as Special Purpose Application Software.

Examples : Adobe PageMaker, Corel Draw and Tally etc.
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(c)  Utility Software : Utilities are those helpful programs that ensure the smooth functioning of the
computer. Utilities are meant to assist your computer. Some utilities help you backup data, some help remove
outdated files or recover data that has been accidentally erased etc. Utility are those application programs that
assist the computer by performing housekeeping functions like backing up disk or scanning/cleaning viruses etc.

Some important utilities are:
(1) Text Editor
(i)  Backup Utility
(i11)  Data Compression Utility
(iv)  Disk Defragmenter
(v) Antivirus Software

Exercise

1. Fillin the blanks:
a. refers to any physical component of'a computer.

b. Motherboard is also called .
c. are the printed circuit boards use to hold the chips.
d. is considered as a heart of PC.
e. The software that are required to control the working of hardware and aid the effective
execution of a general user's applications are called software.
2. Write True of False for the following statements:
a. You can touch software.
b. Motherboard contains CPU and other chips.
c. The rear of a PC has many empty holes of external socket called cords.
d. MS-Word is special purpose application software.
e. Assembler is a language translator.
3 Classify the following components of a computer into Hardware and Software:
a. Keyboard: b. Floppy Disk
C MS-Dos : d. Printer Cord
e Anaccounting program: f. Paint
g CPU : h. Sound card
i Windows 98 : J- MS-excel
4. Answer to the question given below :
a. What s difference between Hardware and Software?.
b What is the difference between System Software and Application Software?
C What is language translator? Name three types of language translators.
d. What is the difference between interpreter and compiler? Give an example of each.
e Name four types of utilities.
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CHAPTER 4
FEATURES OF WINDOWS

Windows is one of the most popular operating system of today's world. It has got some very useful
features that makes it user friendly. e.g. windows 98, windows Me, windows XP etc.

Letus learn about them one by one:

1. Desktop
The screen in which icons, windows etc. are displayed is known as desktop.
The desktop may contain a background, one or more active or inactive windows, a taskbar and icons. You

can see in figure.

' -
&

Fig 4.1 The desktop

2. The Icons
Icons are the pretty pictures representing windows elements like files, folders, shortcuts etc. or in other
words icon is a graphic symbol representing a window elements. You can see in fig.

Fig 4.2

Various types of icons.



3. The Task Bar and Start button

We can use the taskbar and start button to navigate through windows.

s TheTaskbar
The bar that is generally found at the bottom of screen.
The taskbar contains start button, clock, some toolbars (a toolbar is a bar containing icons for
various tools) and the buttons corresponding to all open windows. See in fig.

Ble =G|

s StartMenu
When we need to start a program or application click on the start button. A vertical menu will
appear at the bottom on the desktop. See in fig.

Fig 4.3

=
[!! Microscft Office Access 2007 »
25/ Microsote Office Word 2007 v

1.' Getting Started »
:‘; Windows Anytime Upgrade

® wordpad
||E/| Microscft Office PowerPoint 2007
E Microseft Office Word 2003 ,
h 3
E Microscft Visual Basic 6.0

_;,] Notepad

LA

| 2|

Files and Folders

To understand this take an example of a library where books are arranged subject wise in different cabinets.
Similarly, in a computer one would like to arrange data topic wise. The cabinet of the library can be referred to as
a folder and books as files.

A Fileis simply a set of data or information referred to by a name.
A folder is used to store a group of files on a disk in an organized mode. A folder can contain files and other
folders.

Folders are also called Directories.

Creating folders on the Desktop
To create anew folder on the desktop, place the pointer on the desktop and click the right mouse button.
A pop up menu appears

e C(Click onthe new option. Anew folder appears on the screen.
e Typethe name of new folder.
e Anicon for the folder with the new name appears on the desktop.

* Youcanalso create folders with windows explorer using similar steps.
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Start menu Options

» Programs

It opens a list of various folders and their programs to choose from to run them.
» Documents

It gives you access the documents stored in document folder.

B 2dobeReader 8

© Default Programs

@ Desktop Gadget Gallery

@ Intemet Explorer

%. Windows Anytime Upgrade
55 Windows Fax and Scan

Windows Media Player S
& Windows Update Pictures
4 XPS Viewer

4. Accessories Music

L Games

.. Maintenance
4. Microsoft Office

Games

. Microsoft Visual Studic 6.0 Computer
1. Microsoft Web Publishing
J. Mcbile Partner C ol Panel
4 Startup
J. WinRAR Devices and Printers
Default Programs
Help and Support
(4 Beck
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~ =
. i Y
o ) ol
e =2
Fig 4.5

» Control Panel
It provides access to control panel, Printers, Taskbar and Start button, folder options System and security,

Network and Internet, Hardware and sound and other windows settings icon.

ﬁ » Control Panel » v]‘,”;’s:':" Control Panei ol

Adjust your computer’s settings Viewby: Category ¥
iy System and Security User Accounts and
Review your computer's Family Safety
status % Add or remave user

Back up your computer
Find and fix problems

accounts
W Set up parental controls
for any user

Network and Internet
tl Connect to the Internet Appearance
S&®.,  View network status and tasks h Change desktop background

Choose homegroup and Adijust screen resclution
sharing options

Clock, Language, and
i Hardware and Sound /A% Reaion
View devices and printers | 9
= - Change keybeards or other
Add a device

input methods
Adjust commonly used

mobility settings Y Ease of Access
| Let Windows suggest settings
m Programs Optimize visual display

Uninstall 3 program

Fig 4.6
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> Help and Support
It opens another window, which help you to provide information regarding windows problems. Pressing
F1 can open help.

© W P« W &

Ask Options ~
Hie:v:h Helo p|

-

A You're not connected to online Help, which shows you our [
latest content. Check your Internet connection, and then try
to connect to online Help again. If you still see this
message, the online Help service might be temporarily
unavailable.

Find an answer quickly

Enter a few words in the search box above,

Not sure where to start?
= How to get started with your computer
m Learn about Windows Basics

m Browse Help topics

More on the Windows website

Check out the Windows website, which has
mare infarmatinn downlnads and ideac for
& Meore support cptions

-

@ Offline Help ~

Fig 4.7
> Search

Using this you can search for a file, folder, of a computer. You can make Specific search of file and folders
date wise, name wise, file type wise and content wise.

B8 Adobe Reader 8
@ Default Programs
@ Desktop Gadget Gallery
@ Intemnet Explorer
‘". Windows Anytime Upgrade
4 Windows Fax and Scan
Windows Media Player
ﬂ Windows Update
-4 XPS Viewer
Accessories

Type file name to |77
SeaI'Ch here Microsoft Office

Microsoft Visual Studio 6.0 Computer
. Microsoft Web Publishing
J. Mobile Partner Control Panel
. Startup
WinRAR Devices and Printers

Documents

Pictures

Music

Games

Default Programs

Help and Support
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» Shutdown

Shut down is used to close or restart the system properly. You can shut down your computer using these

steps:

Click on Start button on the task bar.

Click on the Shut down.

. Adobe Reader 8

e Default Programs

@ Desktop Gadget Gallery

fé Internet Explorer

";'. Windows Anytime Upgrade
#3 Windows Fax and Scan
Windows Media Player

E Windows Update

Documents

Pictures

<4 XPS Viewer

|, Accessories ——

.. Games

.. Maintenance M

1. Microsoft Office

. Micresoft Visual Studic 6.0 Computer

.. Micresoft Web Publishing

. Mebile Partner Control Panel

). Startup

.. WinRAR Devices and Printers
Default Programs
Help and Support

4 Back

[Search programs and f 7]

Fig 4.9

To restart you can select restart option and click on ok.

Click here to
shut down
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Windows Accessories

Accessories can be accessed from start menu and programs. There are various heads in accessories, each giving
rise to different options, which are grouped in categories.

These can be listed as:
1. Accessibility

» Accessibility wizard
» Magnifier

2. Communications

» Dial up networking

» Direct cable connection

» Hyper terminal

» ISDN configuration wizard
» Phonedialer

3. Entertainment

» CDplayer

» Sound recorder

» Volume control

» WebTV for windows
» Widows media player

4. Games

» Freecell

» Hearts

» Mine sweeper
» Solitaire

5. System tools

A\

Backup

Character map
Clipboard viewer
Compression agent
Disk cleanup

Disk defragmenter
Dive converter (FAT 32)
Drive space
Maintenance wizard
Net watcher

Scan disk

YVVVVYVYVYYYVYVYYVY
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» Scheduled task
» System information

» System monitor

6. Calculator

7. Imaging
8. Notepad
9. Paint

10. Word pad

Parts of a Window Screen

A window is a typical rectangular area related to an application or a document.

An application window contains an open application such as word or paint. Many applications can be open or
running simultaneously but there is only one active window at a time.

An application window has many elements like:

Title bar

Menu bar

The workspace
Scrollbars

Corner and borders

YV V V V V

Control menu

1. Title Bar
It is the topmost bar of each application window and it contains the title of the open window.
Apart from the title it has several other elements like application icon, active file name, minimize button,
maximize /Restore button and close button.
See Fig.3.10

2. Menu Bar
The menu bar of an application window is a horizontal bar that below the title bar.
The menu bar lists the menus available for that application.

3. The Workspace
This is the area in a window below the title bar and menu bar. Everything that relates to the current
application is displayed in the workspace.
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Title Bar

4, The Scroll Bars

==~

t_“
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[
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Window's title
name

Corners and
Borders

Fig 4.10

Depending on the size of a window, the entire application may not be visible. When this happens the
window is outfitted with vertical and/or horizontal scroll bars.

5. Corners and Borders
To resize a window, use the mouse and point to a windows border and corner.
The mouse cursor changes to a double arrow when positioned over a border or corner. Drag the mouse

button to reshape the application windows.

6. Control Menu

The menu which appears when we click on upper left corner of title bar containing Restore/Maximize,
minimize, and close options.
This can be done by using control button on the right most of title bar like:

Maximize / Restore

This button is used to enlarge the window and to restore the enlarged window to its previous size.

O d
Restore
Move
Size

= Minimize

o Maximize

x Close

5 | Document

Alt+F4

(=)

o D

Minimize

Maximize /
Restore

Fig 4.11



Minimize

This button shrinks the active window to the task bar.

Close

This button closes the active window from the desktop.

Exercise

1. Fillin the blanks:

a.
b.

e

Menus are located at bar.

The overall area of the window's screen is called
Scroll bars are used to the workspace of window.
is a graphic symbol representing a window element

gives you access the last 15 documents opened.

2. Write 'T' for True or 'F' for false statements:

A

Windows is an operating system.

Using search you can search for a file, folder, of a computer.
Scroll bar is used to Scroll the screen up or down and left or right.
Many applications can't be open or running simultaneously.

Accessories can be accessed from start menu and programs.

3. Write short notes:

1. Shutdown.
2. Run.
3. Helpand Support.
4. Menubars.
5. Accessories.
4. Answer the following questions:
a. Whatis Desktop?
b. Whatare the functions of minimize, maximize and restore button.
c. WhatisIcon?
d. Whatdo youunderstand by windows?
e. Whatdo youunderstand by title bar and menu Bar?
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CHAPTER 5
BASIC WINDOWS ACCESSORIES

There are some very useful tools of windows like:

Calculator
Character map
Notepad

Date and time
Paint

YV V VYV V

1. Calculator
Windows gives you the choice of both standard and scientific calculator for doing the calculations while
working on the computer. As shown in figure

View Edit Help

MC || MR || MS || M=+ M-

9
- 5| 6 * || 1/x
3

Fig 5.1

Standard Calculator
To Start Calculator
We can follow these steps :

* Clickon Start All Programs Accessories Calculator
* The calculator has two types of views

» Standard
> Scientific

—(w)



1.1 Standard

It has general view of calculator which perform simple mathematical operations like +, -, /, *, % etc.
You can see above, the figure of standard calculator.

View Edit Help

MC [| MR || MS || M=+ M-
-— CE C ch v
7( 81| 9 /|| %
41|15 6 * || 1/x
1-Jf 2 §3 o |

0 + -

Fig 5.2

Standard Calculator

1.2 Scientific
It has some special extra buttons apart from the standard calculator buttons. See in figure

Fig 5.3 Scientific Calculator

You can see in figure there are many buttons like sinh, cosh, tanh, mod, Exp, &, etc.

1. The Character Map.

Character map is used to insert special character into a document. You can also open character map by
clicking Start, pointing to All Programs, pointing to Accessories, pointing to System Tools, and then
clicking character map character map works only with Windows-based programs. You can see in figure.
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Fig 5.4

3. Date and Time

You can see or adjust the date and time of your system using date / time property. You can open this
property from control panel using these steps.

Starts Control panel —Date / Time.

Set the date and time:
Date: Time:
4 April, 2013 »

Su Mo Tu We Th Fr Sa
31 1 2 3 4 5 6
7 8 9 10 11 12 13
14 15 16 17 18 19 20
2 2 3 u{Hle 27
28 29 30 1 2 3 4
5 6 7 8 9 10 11

Change calendar settings

[ OK ] [ Cancel ]

Fig 5.5
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PAINT

Paint is a drawing tool provided by windows. It is used to make very simple drawings using various tools such as
Brush, Lines, spray etc. You can add text to your images also. It is not a very effective tool for editing pictures.

The paint can be opened from
Start » Program files » Accessories » Paint

(S kd % = | Untitled - Paint - - (o] @ |3
Home View (7]]
B 2|2 — DDIIIIII ll:ll.

Color | Color Edit
colors

1 2

Menu bar

Canvas or
Drawing Area

Toolbox

m

Color palette

m

e (= 100 1024 x 768px 100% (= {J (+

Fig 5.6

The paint contains three main tools for drawing as in figure:

1. Canvas
2. Tool box
3. Colorpalette

1. Canvas
The drawing area provided for the user for drawing objects. The tools of toolbox are used here for drawing.

2. Tool box

The box that contain all the drawing tools like pencil, fill color, etc
As shown in the figure above.
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Description of Tool Box items

1. Select
This tool is used to select the rectangular region of the picture.
2. Eraser

This is used to erase the part of the picture.
3. Fill color
The fill color tool is used to fill the desired color in bounded region of Picture.

4. Magnifier:

We can see the enlarge view of a picture.
S. Text:

We can insert text on the picture using text tool.
6. Curve:

We can draw line, rectangle, polygon, and ellipse/ circle using different tools like line, rectangle, polygon
and ellipse respectively.
3. Color palette
Color palette contains several colors, we can select colors from the palette to use it in picture.

Drawing with paint
1. Todraw picture, first click left mouse button over the brush or the pencil tool in the toolbox.
2. Move the pointer on to the screen. Keep the left mouse button pressed all the time as you draw.
3. Toclearthe screen and start again , hold down the Ctrl and Shift along with N on the keyboard.

Coloring with paint
1. Tocolorapicture, first click on the fill color tool in the toolbox.
2. Nextchoose the color from the paint box at the bottom of the screen by clicking the left mouse button
onit.

3. Move the pointer over the screen. It will change into the fill color tool. Put its tip over the area you
want to color and click.

Menus in paint
There are six menus in paint for various purposes as

1. Home

2. View

(=)



1. Main Menu:

The file menu contains options like New, Open, Save, Save as, Print preview, Print etc.

=" send in e-mail

a Set as desktop background »
J Properties
6 About Paint

>

Exit
b

Fig 5.7

2. Home Menu:

The home menu contains options like Cut, Copy, Paste, crop, resize, rotate etc.

E@ Copy £ Resize

Paste -
= "\ Rotate ~
Clipboard Image
Fig 5.8
3. View Menu:

The view menu contains Zoom in, Zoom out, Rulers, Grid lines, Status bar etc.

Home

>

>

Y

YV V V

100

View

memory.

Rulers

Gridlines

New is used to create a new file in paint.

Saveisused for save a file in the disk.

Save as is used to prepare another copy of file.

Printis used to take the print out of file from the printer.

-

A =

Full Thumbnail |

Zoom Zoom
in out % v Statusbar | screen
Zoom Show or hide Display
Fig 5.9

Open is used to open a file that is already exist in computer

Print Preview is used to see the preview of file before printing.

After selecting the matter we can cut / copy to paste it at different
location.
Selectall isused to select whole picture at a time.
Crop is used to cutimage as per need
You can change the size of image

rotate is used to rotate a picture by given angle.
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» Rulers displays rulers on the window
» Gridlines helps to draw image according to scale
» Status bar displays help of the activated option

Notepad

Notepad is a built- in windows text editor, which is used to write application, letters, short notes, etc. The
extension of notepad file is ".txt." It is also used to write source code of the web designing languages like HTML,
DHTML etc.

Starting of the Notepad

To start notepad you have to follow these steps:

> Click on the Start button.

> Typenotepad on the search box

Click on the notepad.

» The following notepad program displays its window containing title bar, menu bar and work area

v

with anew document.

Programs (1)

| Notepad

Type Notepad
to open

- See more result

notepad 4 x | | Shutdown | » |

Fig 5.10

Once the text is typed it can be saved, printed or formatted as per the requirement using the
commands of menus available in menu bar.
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The notepad contains five menus as File, Edit, Format, View and Help.

File Edit Format View Help

| -

Fig 5.11

The File Menu

This menu bar has the commands to open a new or existing file, save or print it and
set or change the page settings etc.

> Click New to open a new untitled file.

| Edit_Fermat View Help | 5 Click Open to open the existing file.
:::n... E:::z > Click Save to save the file by giving the file name or an existing file with same
Save Ctrl+S hame.
Save As.. > Click Save As command to save the opened file with the new name.
Page Setup... > Click Page Setup option to change the page setting like margins, orientation, etc.
Print... Cur+P » Click Print command to print opened file.
Exit > Click Exit to close the notepad program.
Fig 5.12

Opening a file in Notepad:
To open an existing file click on File -Open.
A dialog box will appear as shown in figure.

%v[@] ¥ Libraries » Documents » v]‘,” Search Documents ,91

Organize v New folder =~ (@

¢ Favorites ~  Documents library
. 4 Dask!op Includes: 2 locations
8 Downloads
%l Recent Places

Amange by: Folder ¥

Name ° Date modified Type

4. Updater5 4/22/20138:42 AM  File foldes
w4 Libraries

@ Documents

o' Music
| Pictures
. Videos

/& Computer Flg 513
& Local Disk (C:)
ca svmd (D:) > n, J L3

File name: | ~+ [Text Documents ¢:6) -

Encoding: lANSE "J I Open I [ Cancel ]
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Saving a document
To save a file in notepad click on, File & Save
A dialog box appears as shown below.

e As F
@ |'E] » Libraries » Documents » v | 4y H Search Documents pl
Organize v New folder = o

43¢ Favorites — Documents library Brngeby: Folder »
Bl Desktop Includes: 2 locations
% Downloads Name : Date modified Type
%l RecentPlaces |
1 J Updater5 4/22/20138:42 AM  File folder
4 Libraries
b |5 Documents i ]
> o) Music n Give the name of file
I =) Pictures
b B Videos
4 8 Computer aall ] ¢
File name: m / -
Save as type: [Text Documents (") v]
=~ Hide Folders Encoding: [ANSI vJ [ Save ] [ Cancel ]
Fig 5.14

Printing the document

To print the opened document click on File & Print command in notepad.

Edit menu
BRE) FormatView Help This menu is used to Cut, Copy, Paste, or Delete the selected part of the opened
Undo Ctrl-Z document.
Cut CtrleX And Select All is used to select whole document at a time.
Copy CtrlsC You can see in this figure:
Paste Ctrl+V
s o » Undo is used to take the effect return of the just used command.
im:“ﬁ C""Ff > Cut is used to move the selected text anywhere in the same or different
R:Iplaczt. Ctrld-l:l’ document.
Go To... Ctrls G » Copy is used to make the Duplicate copied of any matter anywhere in the
e = same or different document.
Time/Date £s » Paste is used to insert cut or copied part of text.
Fig 5.15 » Delete is used to delete selected text
» Select All is used to select the whole text at a time.
» Time / Date is used to insert current date and time.
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Format Menu
This menu is use to distribute text into lines and set Font styles of the text.

2 Untitled - Notepad
File Edit BEEinE# View Help

Word Wrap |
Font...
Fig 5.16
Cut and Paste

To cut and paste follow these steps:

> Word Wrap is used to distribute the text into lines.

» Select the text or a part of text is to be cut.
» Click on Edit = Cut.

» Move the cursor to the required location where text is to be paste.

» Again click on Edit =& Paste.
Copy and Paste
To copy and paste follow these steps:

» Select the text or a part of text is to be cut.
» Click on Edit = Copy.

» Move the cursor to the required location where text is to be paste.

» Again click on Edit = Paste.

Changing font, font style, and font size
To change the font, font style and font size follow these steps:

Font
Font: Font style:
Lucida Console Regular
ucids Console B
Lucida Fax
Lucida Handwritiy
Lucida Sans

Lucida Sans Typewri =
Lucida Sans Unicode ~

> Click on Edit = set font.
» A font dialog box appears.

» Font option is used set any font, font style, and size of document.

Sample
» You can select font, font style and size from the lists
N o provided in the dialog box.
Seript » Click OK after selecting the font attributes.
Western -
Show more fonts
[ ok ][ concel
Fig 5.17
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Exercise

1. Choose the right answer :

a. The desktop may containa -

(1) background (i1)) Onlyredcolor (iii)) Outputdevice (iv)
b. The bar that is generally found at the bottom of screen -

(1) Taskbar (i1)) Toolbar (ii1) Status bar (iv)
C. Shut down means -

(1) Closeorrestartwindow (ii) Storedata (ii1)) Savedata (iv)
d. Solitaireisa -

(1) Game (1)) Song (i11) Picture (iv)
e. Choose the name of'the text Editor -

(1) Notepad (i1)) Paint (i11)) Image (iv)

2. Fill in the blanks:

a. A tool isused to select a part of an object in rectangular shape.
b. Totypethetext toolisused.

c. tool isused to erase the part of the picture.

d. Bydefaultan extension isadded to anotepad file.

e. Thejustdeleted text can be undeleted using command.

f.  Thecodes of HTML language can be written in document.

g. properties is used to change the system date or time.

3. Write 'T' for true and 'F' for false for following statements:

Any picture can be inserted into Notepad.

a.
b. Notepad is nota word processor.

o

Notepad is able to change the font style of the typed textin it.

&

document.
Polygon tool is used to write the text.

Magnifier tool is used to erase the lines and colors.

(=)

None of these

All

None of these

All

Coral Draw

Time / date command of edit menu is used top insert the current system time and date in any opened



Write short notes:

a.
b.
C.
d.

.

Time /date command in notepad.
Cut and paste.

Copy and paste.

Saving in notepad.

Standard and Scientific calculator.

Answer the following questions:

o ®

0 a0

Whatis Notepad?

Define the Save and Open command in paint.
Define the cut, copy, paste commands.

What does a text tool do in paint?

Define a font, font style, and size.

What are the uses of View menu in paint?

Whatis the use of Date / Time properties.

Hands on practical:

Draw an object and scatter blue color init.

Draw arectangle and fill yellow colorin it.

Draw a polygon in pentagon shape and fill different colors.
Write a letter in three paragraphs.

Change the font, font style, and size of it.

W Microsoft Word - Documentl

|®)Ele Edt vew Insert Fomst Tooks Table Window telp
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CHAPTER 6
INTRODUCTION TO MICROSOFT WORD

A word processor is a software package that process textual matter and creates organized documents. It has all
the features that a conventional typewriter has, apart from typewriter.
Microsoft word popularly known as MS Word is a popular word processing software.

STARTING WORD

To start word, follow the steps given below:

» Click on the start button in the task bar.
» Move the pointer toAll programs in the start menu.

» Inthe All program menu move the pointer to Microsoft Office. And click on the Microsoft Word.

.\ ﬂ 9 -0 ) s Documentl - Microsoft Word - ] X
Home  Insert  Pagelayout  References  Mailings  Review | View | (7]
59 Web Layout E’ &J 3 New Window | 1) E -
Print |Full Screen Show/Hide| Zoom S i Switch Macrs
Layout| Reading L=l Draft - - £ Split A4 | Windows ~ -
Document Views Window Macros

Fig 6.1

Parts of word screen
The MS- word screen also known as the document window, appears on your screen. The cursor appears on the
first line and first column in the work area for you to start typing the text in the document.
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The Word screen contains following components

Title Bar

Title Bar is at the top of the window. It displays the control menu icon, the name of the program, the name of the
current active document, and the three buttons, namely, minimize button, maximize or restore button and close
button.

Menu Bar
It is placed just below the title bar. It contains the names of various menus like Home, Insert, Page Layout etc.
Each of these contains different menu's tools.

Formatting Tool Bar

Formatting toolbar shows shortcuts for the tools related to formatting of the text in the document. These
toolbar help to perform task easier and faster. It contains icons like Font, Size, bold, italic, underline, and
alignment options.

Calibri (Body) vj11 - [ es————— "T‘.'Hi? = A/ % )
B I U -~abe x, 3|9 |==E = B =

—_ 3 *:
= : ol = Quick Change Editing
22~ A~ | AT EeRaR=iRdIE2YIK & Styles~ Styles~ ||~
Font ls Paragraph M Styles la

Fig 6.2

Ruler
The ruler bars are present on the top and the left side of the document. These are used to set the margins of
the document, as well as set the tab stops and indents.

Status Bar

Situated at the bottom of the word screen, the status bar displays the information about the current active
document or the task that you are currently performing. For example the page number, line number etc. in
which the cursor is currently positioned.

Scroll Bar

The word document window has two scroll bars i.e. horizontal scroll bar and vertical scroll bar. The horizontal
scroll bar is used to move the document horizontally, while vertical scroll bar moves the document vertically.
The vertical scroll bar has four buttons;

Those with single arrows scroll the document up and down one line at a time. Those with double arrows scroll the
one page atatime.
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Creating a New Document in MS-Word

To create anew document in ms word, follow these steps:

Click on Office Button to open the menu.
» Selectthe New option from the office button. A dialog box is appeared as shown in figure.
» Click on the Blank document icon.
» Now aBlank document is available for your work.

Templates “|l « = s3] Blank document
| Blankandrecent |
Installed Templates Blank and recent

My templates...
New from existing...
Microsoft Office Online

Featured
Agendas

Award certificates

Brochures
Business cards New blog post
Calendars
Contracts
Envelopes
Faxes

Flyers

Forms

Gift certificates

Greeting cards -

[ Create ]‘ Cancel

Fig 6.3

Saving a Document

When a document is typed. It is stored in the computer memory. To be further use it must be saved in the disk.
To save a document, follow these steps:

» Click on office button.

» Select the Save button from the appeared menu.

» The Save as dialog box will appear as shown in the figure
» Selectappropriate folder to save your file.
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» Give a proper file name to save your document. Click on save button. The document will save with

the specified name. By default, a word document is saved with .docx extension.

) Save As =l
O—CJ f‘ » Libraries » Documents » - | +4 H Se ;:'i
Organize « New folder = .. 0
e \ Uments library ... —
Se|eCt Includes: 2 locations Rt o [FRS
appropriate 5% - Name Date modified Type
wnloads Updater5 4/22/20138:42 AM  File folder
folder to save |77 ?
your file
¢| Documents
JW Music
Give file ) Pictures = L) y
. = -
name her
. _jm: 1Word Document bt
Authors: svm Tags: Add atag
] Save Thumbnail
= Hide Folders Tecls = Save Cancel
Fig 6.4 The Save As Dialog Box.
Opening an existing document
The steps to open an existing document are as follows:
» Click on office button to open the file menu.
» Select the open option from the menu.
» AnOpendialog box will appear on the screen. As shown in figure.
1] Open X
O—Q [T5 » Libraries » Documents » - I 4y ” Search Documents pe]
Organize v New folder - [l @&
[ Microsoft Office W Documents libra S
Templates Includes: 2 locations Select the
S o Neme appropriate ed Type
i Besksip |. Updaters drive & folder [@av  Fietoie
B Downloads £ rajesh 52 PM HTML Do
=\ Recent Places G |Ve the name
4 Libraries Of file yOU Want
4| Documents to open.
J’ Music
! Pirtires > ] »
File name: - [AII Word Documents ']
Teols ~ [ Open i'] { Cancel ]

Fig 6.5 The Open Dialog Box.

» Selectthe drive and folder in look in box where required file is located.
» Selectthe file from the list or type the name of the file in the file name box.

» Click on the open button.
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Cursor movement
To move around in word document, arrow keys left, right, up, and down can be used. However, there many
other keys and key combinations available in word for navigation.

The scroll bar can be used in various ways to scroll through document. As shown in figure.

The horizontal
scroll box

Left scroll
Arrow

Up scroll arrow

The vertical scroll box.

Down scroll arrow

Fig 6.6

Entering and editing text

Entering text

To creating a new document, a blinking vertical line called cursor can be seen in the workspace. The cursor
shows position where text will be typed. Start entering text by pressing keys on the keyboard.

Press the < Enter > button to come to the next line if you want to change the paragraph. The text will come in the
next line automatically, as you continue typing. This feature is known as word wrap.

Selecting text

Either using the mouse or the keyboard can select a part of text.

Selecting text with mouse

To select a part of the text using mouse, click the left mouse button at the beginning of the to be selected and while
holding it down drag the mouse to the end of the text. The desired text gets selected and highlighted.
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Selecting A Text With Keyboard

To select a part of text using keyboard, bring the cursor to the beginning of the text to be selected. Hold the shift
key and press the arrow key to move the cursor to the end of the text the text gets selected and highlighted.

Editing text

Editing means making changes in the already typed text. To do any editing in the text, the text need to be selected.
You can select the text to be edited either by using mouse or keyboard and then make changes by using the
editing tools described as follows.

Cut and Paste
If we want to move a part of text from one location to another we can make use of cut and then paste options. To
move text from one location to another follow these steps.

ie's \
- _ & » Selectthe textto be cut.
l » Click on the Home menu.
- —*\ﬁ » Click on Cut option or you can click on the cut icon of standard tool bar.
Paste » The selected text will be disappearing.
— j » Move the cursor to the location where text has to moved.
» Again click on Home in the menu bar and click on Paste option.
Clipboard '+
Fig 6.7
Copy and Paste

If you want to retype a part of text at another location then it can be done by copy and paste operations. To copy
text from one location to another, follow these steps:

Select the text to be copied.

Click on Home menu.

Click the copy option or you can click on copy icon on the standard toolbar.
Move the cursor to the place where the text is to be copied.

YV V VYV

Again click on Home menu then click on Paste option.

The selected text gets copied in the new location.
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Exercise

1. Fillin the Blanks
a. in the document window displays the page number
Where the cursor is currently placed.
Microsoft word is a

b
c. The ruler bars are present on the and the side of the document.
d. The horizontal scroll bar is used to move the document

e. Menu bar contains the names of various

2. Write 'T"' for true and 'F' for False statement.
a. A text must be selected to copy it.
b. Standard toolbar contains the Print icon.
c. Formatting toolbar contains the print preview icon.
d. After copy you can paste the text anywhere in the document.
e. The status bar displays the information about the current active document.

3. Write Short notes

Cut and Paste.

Copy and Paste.

Cursor movement.
Parts of window screen.

Selecting text with Mouse.

moe e o oo

Selecting a text with Keyboard.

4, Answer the following questions.
a. Whatis word processing software?
b. Write the steps to open a new document in word.

How can youmove a text from one position to another in a word document?

a o

Write the steps to save and open the document in MS-Word.
e. Explaindifferent type of Bars in Ms-Word.

5. Hands on practical
Open a new document in Ms word. Observe the word screen
Carefully. Do the following.
v" Type a paragraph of your note book in word.
V" Save file with the name “My Paragraph”.
v" Draw the title bar in your notebook.
v Draw the sketch of standard tool bar in your notebook.
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CHAPTER 7
THE FORMATTING AND PRINTING IN WORD

The process of changing and controlling the look of a document is known as formatting. Formatting of a
document includes changing the size and style of letters, making some text bigger or border, adjusting the line
and paragraph spacing, changing the alignment of text with respect to the page margins, and setting the page
margins etc.

You can apply formats to specific characters like headings, titles to large section of the text (like paragraph) or to
the entire page or document. So, the process of formatting in MSWord is divided into three parts.

» Character formatting
» Paragraph formatting
» Page formatting

Character formatting

To enhance the appearance of the document, character formatting plays a very important role. It includes
changing the font type, size, color of the text and making the text Bold, Italic or Underlined.

By using the formatting tool bar or Font dialog box character formatting can be applied.

How can we change the Font style?

Font represents a style of characters in which text is displayed in the document. Different fonts contain different
collection of characters and symbols.
To format the characters in word, follow these steps:

Font L2 sl

Font | Chagacter Spacing |
Font: Font style: Size:
Agerian Reguiar 1 » Select the text whose font is to be changed.
| +Body - Regula A 8 -
|+ i Italic 9 .
it Boic 0 » Click on the Home menu.
|Aharoni Bold Italic 11 |
fgern g ad | FPIAS -
B — T — » Select the Font option from the appeared Tool a
Font golor: Underiine style: Underline color .
automate  [w] | (none) [2] [ Automate drop down list appeared.
Eﬁ!m . . . . .
Strigsthrough Gt T » The Font is displayed in this figure with the
e < S bounded region of dots.
Sut ipt E v . . . .
: spscro e » Select the font from the list by clicking on it. The
SVIeW
font type gets applied on it.
[—— ype g pp
This is a TrueType font. This font will be used on both printer and screen.

7
E

[ ox ][ concel

Fig 7.1
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How can we change the Font Size?

The Font size is used to increase or decrease the size of letters. It is measured in points. Points are used to measure
character height. A inch contain 72 points.

The steps to change the font size are:
» Firstofall select the text whose font size has to be changed.
» Click on the Home menu.
» AFontdialog box appears in which you can select the required font size. And click on Ok.

» The font size gets applied on the text.

You can change the font size from formatting toolbar also. As shown in figure

Calibri (Body) - | =
(B £ U ~abe X, 18 _»

\m
22~ A~ As~||A a]°

You can change
Font ~ the font size from
1.......8......‘-_‘.12 here.

»  Afterselecting the text we can apply font size from the formatting toolbar.

Fig 7.2
How can you change the character attribute?

The Bold, Italic or Underlined are used to enhance the character's importance. It is used, so that the document
reader knows that they are emphasized.

To apply these attributes, follow these steps:
» Firstofall select the desired text.
» Click on Home menu in menu.
» Adialogbox will appear.
» Select the font attributes like Bold, Italic, or Underlined.
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The character attributes can be applied by formatting tool bar also. As shown in figure

IBM{’
B U~ abe X, X

You can apply character
attributes by clicking on |

Fig 7.3

Paragraph Formatting

The text followed by the enter key is a paragraph. Paragraph formatting is one factor that contributes the most to
the final appearance of the document

The paragraph formatting includes: text alignment, tab stops, paragraph indentation, line spacing, and border
and shading.

Text Alignment In Word

MS-Word offers you four types of text alignments as Align left, Align right, Center, and Justify.
To change the alignment you can select the text and then click on the alignment button on the formatting tool bar.
Asshown in figure

Align left CenLe\r Align Right Justify

e
il
q

Fig 7.4
Left Alignment
If the text is aligned to the left margin of page, it is called that text is left aligned. To left align the text put the

cursor in the paragraph and click on the left align button on the formatting tool bar. Left is default mode of
alignment. As shown in figure

Modem is a device
attached to
computers that can
convert digital

signal to analog.
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Center Alignment

The text is called centered align, when the text is reside in center between the left and right margin of the page. To
center a line or paragraph, position the cursor any where in the paragraph, and click on the center button on the
formatting tool bar. As shown in figure.

Modem is a
device
attached to
computers
that can
convert digital
signal to
analog.

Right Alignment
Ifthe text is aligned to the right margin of page, it is called that text is right aligned. To right align the text put the
cursor in the paragraph and click on the right align button on the formatting tool bar. See figure.

Modem is a
device attached
to computers
that can
convert digital
signal to
analog. Modem
is a device
attached to
computers.

Justify

Justify aligns a paragraph on both left and right margins. In this type of alignment, the spacing between words is
adjusted so that each line of text begins at the left margin and ends at the right margin. To justify a text, put the
cursor anywhere in the paragraph, and click on the justify button on the formatting toolbar.

Justify aligns a paragraph on
both left and right margins.
In this type of alignment, the
spacing between words is
adjusted so that each line of
text begins at the left margin
and ends at the right margin.
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Print Preview

This option shows how a document will appear on the paper, without taking the actual print out of document.

To see the print preview we have to follow these steps:

» Click on the Office Button in the menu bar.

» Click on the print preview option in the drop down menu.
» Orclick on the print preview button present on the standard tool bar.

Printing a Document

After typing, editing and formatting the document you can see the print preview. If you are satisfied with

document, you can actually print it to get a hard copy on the paper.
To print the document follows these steps:

» Click on office button. To open the Print menu.
» Click on print option in the file drop down menu.
» Adialogbox appears as shown in this figure.

prin
Printer
Name: ™5  Microsoft Office Document Image Writer B
Type: Microsoft Office Document Image Writer Driver =
Where:  Microsoft Document Imaging Writer Port: (T Print to file
Comment: | Manual duplex
Page range Copies
9 Al Number of copies:
Current page Selection

1 %
S 5 g
Type page numbers and/or page . .

ranges separated by commas counting
from the start of the document or the
section. For example, type 1, 3, 5-12
or plsl, pls2, p1s3-p8s3

Print what: |Document [EI Zoom

Print: All pages in range E] Pagespersheet: | 1page El
Scale to paper size: | No Scaling B

o) o=

Fig 7.5 The Printing Dialog Box.

You can choose the page range by clicking at any of the radio buttons as described in the following table:

Page range, Radio Button Description

All Prints the whole document.

Current page Prints the page where cursor is present currently.
Pages Prints the specified page or a series of pages.

» Type the number of copies to be printed in the number of copies box.
» Click at the OK button to start the printing job.



Exercise

1. Fillin the blanks:
a. Pointsare used for measuring height
b.  radiobuttonisusedto print the whole document.
c. radio button is used to print selected matter.
d E iconisused to the text.

)

U [ iconisusedto the text.
2. Write 'T' for true and 'F' for the false statements:
a. Toemphasize certain words we can make them Bold or Italic.
b. Toprintadocument, click on print preview icon in the formatting toolbar.
c. Justify aligns a paragraph on both left and right margins.
d. Pagesradio button prints the specified page or a series of pages.
e. TheFontsizeisused to only increase the size of letters.

3. Match the following:

A (B)
a. Centeraligned L. =
b. Justify | []
¢. Bold . | =
. . B

d. Rightaligned IV.
e. New V. =
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Answer the following questions:

a. Explain the different types of text alignment.
b. Whatis the purpose of Print Preview?

c. How can we change the Font style?

d. How canyou change the Font size?

e. How canyouprintadocument?

Hands on practical.
v" Type aparagraph ina word document.
v Apply the font Ariel black to the typed text.
V" Make the font size of the typed text as 15 pt.
V" Apply the center alignment to the title of paragraph.
v Make the title Bold and underlined.
V" Make the paragraph justified aligned.
lzllu"" ™ - |5 Bookl - Microsoft Excel o B %
j Home Insert Page Layout Formulas Data Review  View & 0 o @
X Calibri *ii1 ~| W= 5[;]?33 General  ~ A B X~
2 B I U- AN EEEZH $-% 3 M-
Paste o 4 Styles Cells
NP EeeA EEY WA < | % | @
Clipboard 15 Font Mo Alignment » Number P Editing
R G ! I
F A B | c | b | £ F | & | #H | P ia
1 E
! 727 ‘ —
-9
4 4
5 |
7 : _ b = Y
M 4 » M| Sheetl  Sheet2 ~Sheet3 - ¥J ﬂ:l u | »[{ |
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CHAPTER 8
INTRODUCTION TO MS EXCEL

Electronic Spreadsheet

An Electronic spreadsheet is a group of rows and columns. Each row is given a unique number such as 1,
2, 3, etc. Each column is identified by a unique alphabet or pair of alphabets A, B, C, etc. It is also known
as worksheet/spread sheet.

Suppose we want to make a marksheet on the paper. We will first create a table in the form of rows and columns.
Thereafter, we will write the titles and sub-titles. Now write down the marks obtained in various subjects as
shown below :

Mark sheet for the month of April

Subject Marks
English 75
Maths 70
Physics 80
Chemistry 65

Actable looks exactly like an electronic spreadsheet.

Popular Spreadsheet Packages
The popularly used spreadsheet packages are:

Ms excel

Lotus 1-2-3
Calc.
Framework

VP Planner Plus

YV V VY

Ms excel is a very powerful and easy to use spreadsheet package, which is being commonly used these days.

Uses of Electronic Spreadsheets

The electronic spreadsheets are used by a large number of users and they cater to the requirements of the users.
Some of the things that users do with the help of an electronic spreadsheet are mentioned below:
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Prepare the result of any class.
Prepares the Profitand Loss Account.
Prepares Income Statements.
Prepares Tax Statements.

Prepares monthly sales reports.
Prepares a cost estimate for birthday.
Prepares a chart on salary data.

YV VYVYYVY

Starting Ms excel
To startup Ms excel in Windows, you can follow the steps given below:
1. First, click at the Start button, and then go to the 'All Programs' option.

2. Select 'Microsoft Office option And click on Microsoft Excel option.

Programs (2)

|| Microsoft Office Excel 2007
[38] Microsoft Office Excel 2003

7 See more results

]excel x | |®Shmdown[bi
Plla - Ol =]z [T
Fig 8.1 Or

1. Click on Start button.
2. Typeexcelinsearch file and program text.
3. Select Microsoft office Excel option. Excel will be loaded.




Once Ms excel is loaded in the computer's memory, a blank file shoots up on the screen. Aname given to a file in
Ms excel is Workbook. The term Ms excel Document, Ms excel Workbook and Ms excel File carry the same
meaning and can be used interchangeably. This blank file by default gets the name Book1. The extension given
toafilein Msexcel is 'xIsx'.

Screen Elements of Ms excel Window

The different parts of an EXCEL window are shown below:

FORMATTING
TITLE BAR MENU BAR TOOLBAR
NAME \
BOX
O H9 - s \ Microsoft Excel — | X
T teal
o
Home Insert Page Layout Formulas D Review View @

%  Calibri wln - |- General - | A | G=Insert~ x4

NS B I U-AN| EE == R8IE ,|sm % Delete - | (3]~ 44~
aste ——— . e T EEAE |l
CELL ' |~ S A-| ||| |8 5% S E)Format~ | 2~
POINTER Clipboard Font I Alignment I} Number [ Cells Editing |
IR T— ]
B G D E E G H .
ROW
NUMBERS
COLUMN
HEADER

I CELL
STATUS BAR

Fig 8.2

There are anumber of new terms appearing in the EXCEL window. Let us discus them:

1. Row: Rows are horizontal lines present in the worksheet. There are a maximum of 148576 rows
present in the worksheet.
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Row Numbers : Each row is recognized by a unique number such as 1,2,3 etc. these numbers are
present on the left side of the EXCEL window.

Column : Columns are vertical lines present on the worksheet. There are a maximum of 16384 columns
present in a single worksheet.

Column Header : Each column is recognized by an alphabet or pair of alphabets such as A, B, C , etc.
these column headers appear at the top of the column

Cell : The cell is represented by a small box. It is the intersection of a row and column. All the
information in the worksheet is shown in cells. Each cell has some address. This cell address is formed by
the combination of a column letter and arow number such as A1, BS, etc.

Cell Pointer : It shows the currently active cell.

Name Box : It shows the name or address of the currently active cell and is exactly above the column
letter A.

Range of cells
A group of continuous cells 'when selected' is known as the range of cells. All the cells in the range become
highlighted. The range is always specified by the addresses of the first cell and the last cell. In the worksheet
shown below, the range starts from the cell address B2 and continues till the cell address ES. Thus, this range is
written as B2:ES.

(A = H Microsoft Excel = - x
j Home Insert Page Layout Formulas Data Review View 9)
T Calibri -1~ | |= =gl S | General - gelnset~  E - 47~
B, 2
" Q2B I U-AN|IEEZEEH %% 2| . 3% Delete - || (3]~ 44~
@ e-A]  EEe] WS | o cormat~ || 2
Clipboard ™= Font I Alignment fa Number = Cells Editing
\ B2 ~Q £ | &
@Ecc%l
B2 A B € D E F G H [
STARTING ‘\1\
CELL OF 5 = ES
RANGE : ENDING
. / CELL OF
= S RANGE
6
7
2
Ready [Eoa TS Tem—) 3

Fig 8.3

Creating a New Workbook

Sumit wants to store his mark-sheet on the computer. He is required to create a new workbook. So, for creating a

new workbook, Sumit clicks at the office - New menu and then 'Book2' appears on the screen.
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Entering and Editing Data in the Worksheet

Sumit already knows that a cell contains the data entered by you. He follows the following steps to create his

worksheet:

Step 1:

Step 2:

Step 3:

He makes the B2 as the currently active cell. He types the title as
'Marksheet for the month of April'.

Sumitnow click in the cell address B4 with the help of mouse and types
the other sub-title 'Subject'.

Likewise, he clicks in the cell address C4 and types the other sub-title
'Marks'.

Similarly, he types the rest of the mark-sheet details. This is how his worksheet looks like:

@ g LERE ] Microsoft Excel - = x
Ca) =
> Home | Insert Page Layout Formulas Data Review View (7]}

‘-’3 %  Calibri PSRN — =1 % Al = o7~

v || e EE0 AN EEE - ol e e 3 A

'aste == | =EE = == | o umber es ells

- 7 (B S>-A (e e e @
Clipboard ™ Font i} Alignment i Editing |
| B4 - fe| subject ¥

] student

| A | B L€ | D E F G H

1

2 Marksheet for the Month of April

3 |

4 | Subject Marks

5 Hindi 29

6 English 30

7 Mathemetic 12

8 Science 28

9 So Science 24

10 |
Ready

Editing data in Cell Entry
Sumit made a little mistake while typing in. He typed 25 instead of Marks in the cell address C4. He follows the
steps given below to make changes in the worksheet:

Stepl :
Step 2:

Step 3:

Step 4:

(o)

Sumit takes the mouse pointer at the cell address C4 and double clicks.
The mouse pointer becomes 'I' shaped. This is known as Insertion point.
He takes the insertion point to letter 2.

He presses the delete key till the time the complete text '25'is not

deleted.

Sumit now types the word 'Marks' and presses Enter key. His modified
worksheet looks like the one shown below:



Saving a Workbook
Sumit now wants to save the workbook he has created. He knows that a workbook should be saved properly
before closing it. Sumit saved the workbook by following the steps given below:

Stepl: Clickat the office button menu and then select 'Saved' option. The 'Save As'
dialog box comes up on the screen.

Step2: Sumittypes the name of the file as 'Marksheet' in the file name box.

Step 3: Hechooses the location in the 'Save in' box where the file has to be
saved.

Step4: Heclickatthe'Save'button.

fﬂ{~—-v %
[::] » Libraries » Documents » -IS,H Search Documents PI
Organize = Clder = - o
/ - .
STEP3 (& Microsoft Office -  Documents library . )
| Amangeby: Folder =
Includes: 2 locatiens
W Favorites Name ° Date modified Type
M Desktop
2272013 8:42 A
1 Downloads = ) Updaters 4/22/20138:42 AM  File folder
25/2013 2:50
%l Recent Places ) student 4/25/20132:50 PM  Microsoft
4 Libraries
| 4| Decuments
N M + B L] | ¥
File name: -
STEP2 Save as type: {E:d Waorkbook vJ

Authors: svm Tags: Add a tag / STEP4

[] Save Thumbnail

. Hide Folders Toos v [ Save 17| Cancel |
Fig 8.5
Closing a Workbook
Sumit wants to close the workbook created by him. He clicks at the office button menu and selects the 'Close’
option.

If Sumit has made any changes in the workbook after saving it, then EXCEL prompts him to save the workbook
before closing it. He gets the following message on the screen:

A Do you want to save the changes you made to 'student.xlsx'?

Yes No | | Cancel

Fig 8.6
Sumit clicks at [Yes] button to save the changes.
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Opening a Workbook

Next day Sumit wants to open the workbook named 'Marksheet' created by him. He follows the steps given

below to open his workbook:

He clicks at the office button menu and then selects the option 'Open’. An

Stepl :
'Open'dialog box appears on the screen.
[[5 + Libraries » Documents » = [ |[ Search Documents )
amize > New folder =~ 1 ®
STE/ {5 Microssft Office £ Efucu‘:m?:f,,rbraw Arrange by: Folder ¥
I Favorites Name £ Da e Type
B Desktop )
& Downloads 2 'Y U?daters 472 File folder|
R Rocer Plsces &) tjesh 472 HTML De
STEP 3 & student Microsoft
il Libraries
|4 Documents
& Music
&= Pictures
B videos
& Comp - 4 " ) i
Filem ~ [All Excel Files ' | STEP4
Tools = Cancel

Fig 8.7

Step 2: Sumit specifies the location of the file.

Step 3: Selects the name of'the file.

Step4: Heclickatthe [Open] button to open his file.

Exiting EXCEL

Sumit wants to close MS EXCEL as he is feeling tired now. He selects the 'Close' option from the office button
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Exercise

Fillin the blanks :

a. Spreadsheet is a group of rows and columns.
b. M.S. Excelisa software.

C. Rows are lines present in the worksheet.

d. is the intersection of row and column.

e. Cell pointer shows the currently cell.

Write True or False in front of the following statements:

a. A workbook contain a number of worksheets.

b. Acell address is represented by an alphabet only.

C. Arange is a group of continuous cells.
d. You must not save your file before closing it.

e. The defaultname given to a file in EXCEL is Book1.xIsx.

Match the following :

a. Cell Save

b. M.S. Excel Small box
c. New Spreadsheet
d. Ctrl+s New

Answer the following questions :

a. What is an Electronic Spradsheet ? How will you start Ms excel ?
b. Write any five uses of an Electronic Spreadsheet.

c. Differentiate between a workbook and a worksheet.

d. Whatis arange? Give examples.

e. Write down the steps to create a new workbook.

f. Write down the steps to modify cell contents.
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CHAPTER 9
EDITING IN EXCEL

Selecting Cells

Most of the operations performed on the cells are done by selecting either a single cell or arange of cells. You can
selecta single cell, range of cells, entire column, entire row or the entire worksheet. Let us see how to select cells.

Select a Single Cell
» Simply click in the cell that has to be selected.

(=)

Ho-- s student - Microsoft Excel - X
- [Homel Insert  Pagelayout  Formulas  Data  Review View @ — ™ x
E %  calibri Ju | S e WA M=
Paste gl = I 2 '”‘E":I I‘ ;"lleumber'Stylesl Cells m' e
© 7 [@e-AL |[Eam] U e
|Clipboard = || Font || Alignment | | _ Editing |
A2 @ £ |
CLICK IN IPhean] s | c [ o [ k F 6 [ H [
THE — 1] 2
3
15|
M 4 » M| Sheetl | Sheet2 - Sheet3 %J ] !
Ready | L= ] v
Fig 9.1
Select A Range Of Cells

» Place the mouse pointer at the first cell from where the range has to be selected.

» Drag the mouse in the desired direction.
» Release the mouse when the desired selection is reached.

d9-~- = student - Microsoft Excel — ] x
= | Home | inset  Pagelayout Formulas  Data  Review View @ - & X
—':igs. Calibri -l - j'-'ijé'-« %:i‘AiE‘z'y-
LY O S el el RS
- 7 @B (S-A- e - ‘ < | @
(Clipboard | Font 5| Alignment & Editing.

AL ~Q £ ¥
s lasa e o [ e | £ | ¢ H |

CELL RANGE %

AL:C5 n _
0 1
5
6
7 {

8
el
10,
u
|
4 b W] Sheeti ] Sheet2 /Sheets [7¢33 . '
Ready | i}

Fig 9.2




Select Entire Column
» Click on the column heading of the column that is to be selected.

\ ﬂ ) - (u - ) s student - Microsoft Excel s ™ x
Home Insert Page Layout Formulas Data Review View @ - @ X |
| @“ o[- (= & (A =
CLICK AT Par B "I } == ; - ) @]~ A
THE x < E?.’”&" FEES b 2~
HEADING | cipbonra 2| ro e
. Fig 9.3
Select Entire Row g
» Click on the row heading of the row that is to be selected.
\ B ) - (- ) s student - Microsoft Excel - i x

| Home | Inset  Pagelayoust Formulas  Data  Review View @ - = X
@ %  calibri PR =] '
roe B U-|AA||E=SE

3’ B> A-  [EEY
||Clipboard Font e Alignment
\]7 B c D E

CLICK AT THE 2
ROW HEADING 3
a
E
M 4 » ¥ Sheetl | Sheet2  Sheet3 -~ ¥J

Ready |

Select Entire Worksheet
» To select entire worksheet, click on the corner blank header before column A and row 1.

@ﬂq—@-ls student - Microsoft Excel - B x
I | Home | nsent Pagelayout  Fomuias  Data mm@-ﬂ!'
Calibri - .ﬁﬁf [A]

o

gm-.n_r-‘

CLICK HERE
TO SELECT
ENTIRE
WORKSHEET
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Changing Column Width

You can easily change the width of a column with the help of following steps:

Step 1:  Move the mouse pointer over the right line of the desired column header.
The mouse pointer takes the shape of a double-headed arrow.

(N = qu - s student - Microsoft Excel = ] x
~ | Home| Insert Page Layout  Formulas Data  Review View @& - ™ X
e i | S = o i A (159 ) 2 2 O
I:aste -2 ‘iulwn ‘HA: A.' iE! 1§' Number| Styles | Cells @' -
- 8-> A ||| =i | P
Clipboard Font ] Alignment = Editing }
| B ~Q £ |
| 4 . B ¢ c | D E | F | & R
1| !
(2 | Marksheet for the Month of April 3
=
4 Subject Marks
S | [Hindi 90
6 [engiisn 30
| Mathemetic 12
8 Science 28
=3 So Science 24
4 4 » ¥ | Sheetl ~ Sheet2 ~ Sheetd %1 4 | !
Ready |

Step 2:  Drag the mouse in the right side to increase the column width.

Step3:  Adoted line coming up on the screen. This line shows the new column width.
Release the mouse button when the desired width is reached.

Changing Row Height
You can easily change the height of the row in the same way as you have changed the column width. In order to
change the row height, follow the steps given below:

Step 1:  Take the mouse pointer in the lower line of the row header whose height has to
be changed. The mouse pointer takes the shape of a double-headed arrow.

Step2: Move the mouse upwards to decrease the row height or downwards to increase
it.

Step 3 : A dotted line appears on the screen. It shows the new row height. Release the

mouse once the desired row height is achieved.
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@\ﬂ oo s student - Microsoft Excel

| Home | Inset  Pagelayout Formulas  Data  Review m@ = x

- =] x

&  Calibri SE= 5 ‘&

u u .g:
Q

Marksheet for the Month of April

Marks

1 Height: 15.00 (20 pixels)
AaT 90

English 30
Mathemetlc

Copying Cell Contents

If you want to copy the contents of the cell range C2:C7 to D2:D7, follow the steps given below:
Step1:

Step 2 :

Step 3:

Select the cell range C2:C7.

Right click the mouse button and select the 'Copy' option.

.\ ﬂ ) - (- ] student - Microsoft Excel
Home | Insert Page Layout

Formulas  Data nmm@-ﬂx

ﬁ &  Calibri -l -] l-e-'iaa = - &
'®Z U '”A"'f] E=E= A :
Mumber Sbles Ceils
7 (B-&-A -‘l #*ll*']
mpboml & Font
cA X C‘—H Marks
A [ 8 w D l E | F \
2 Calibri ~|11 A XS % 0 F
: Marksheet for the IEE-O-A-R%E
4 St_lbjt_act Marks % cut
5 Hindi 90
- \d} Copy
6 English 30|
7 Mathemetic 12 B paste
8 Science 28 Paste Spedial...
9 So Science 24| Insert...
44 » 4| Sheetl <Sheet2 , Sheet3 |  Delete.
Mrf Average: 368 Count:6 S| Clear Contents
Fig 9.8

Take the mouse pointer at the cell D2.



Step 4:  Right click the mouse button and select the 'Paste’ option. Now final worksheet
looks like shown below:
\ u .- s student - Microsoft Excel oy ] x
| Home | Inset  Pagelayout Formules  Data Review view @ - = x |
E.’-"j f Calibri <l - --ijgi | Arl @ |= g-‘
| st ﬂl—v' ‘ $$' Number S!yles Cells o ‘
Clipboard || Font % Alignment Editing |
D4 - £ | @
_ A B L c o] e | f | 6 |
[ 1 -
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| 7] Mathemetic 12 (@ peste
|Ll Science 28 Paste Spedial...
Iii So Science 24 Insert Copied Cells...
R Sheetl - Sheet2 .~ Sheet3 . ¥J Delete...
mmamamsmmmmem l_ Clear Contents
Fig 9.9
Moving Cell Contents

Moving cell contents removes the contents of the cell from

one location and places it at some other location.

For moving the cell contents, follow the steps given below:

Step 1 : Select a cell or range of cells to be moved.
Step 2: Right click the mouse button and select the 'Cut' option.
H9-o- )= student - Microsoft Excel R ey S0
| Home | Inset  Pagelayout Formulas Data  Review View @ - = X
El Calibri Pl | [ | S ‘ % bl A E W E- 22
Paste “”1: II “A ll|l” ' - ‘S;ﬂ" Icas' m' -
7 (B0 A7 @ M o
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] A | 8 femessl o | e | F | 6 [ na
1 | Calibri -iu AXNS % s F
L2l Marksheet for the Blz=0-9-A-waE 4
3
4| Subject [Marks | o ‘
T i
(7] Mathemetic 12 @B pute
T T Paste Special...
I So Science RO et
LW 4> 0| Sheet1 <Sheetd ‘Sheets | | 27t~ T
Ready | Average: 368 Count:6 51 Clear Contents y
Fig 9.10
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Step 3: Take the cursor to the cell wherever you want the text to be pasted.
Step 4: Right click the mouse button and select the 'Paste' option.

@ H )M~ )5 student - Microsoft Excel — - x
Y
Home | Insert Page Layout  Formulas Data  Review View @ - & X
' ‘“-‘3 &  Calibri -l - [EeeF % AlllE 2 a7~ :
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1
‘ Calibi ~/11 ~ A" A" § -~ %
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6 English 30 g Sovy
i‘ Mathemetic 12 1@ paste
8 Science 28 2 Paste Special...
E So Science 24 2 Insert...
M 4 » M| Sheetl  Sheet2 . Sheet3 . (2 il ™ Delete...
Select destin... | Average:36.8 Count:6 Sum: 184 H@.g! Clear Contents

Fig 9.11
Exercise

Fillin the blanks :
a Simply click in the that has be selected.
b. Drag the in the desired direction.
c. The mouse pointer takes the shape of a arrow.
d. line appears on the screen.
e. click the mouse button and select the copy option.

Write True or False in front of the following :

a. The whole worksheet can be selected by pressing <Ctrl +A> keys together.
b. The mouse pointer cannot take the shape of a double-headed arrow.

c. Copying and moving cell contents mean the same.

d. Row height can be increased as well as decreased.

e. The cell contents can be edited by double-clicking on them.

Answer the following question :

a.
b.

C.

&

Write down the steps to change the column width
Write down the steps to change the row height.

Write down the steps to select entire column.

What is the difference between copying cell contents and moving cell contents.
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CHAPTER 10
FORMATTING AND PRINTING IN EXCEL

Types of Data

EXCEL can very smartly figure out the type of data as you type in. it allows you to type in values and formula
from the keyboard. Values can contain text, numbers or special characters. Let us discuss the different types of
cell entries in detail:

(a) Text Values : Any entry that contains text, numbers or any special character is recognized as a text entry.
A text purely in alphabets is mostly used for giving titles and subtitles. Generally, a text entry is given at
the top and left side of the worksheet. By default, a text entry is left aligned.

Text values are - "Ram Kumar", "Sumit", "ABC 123"

(b) Numeric Values : Any entry is treated as a numeric value if the first character entered is a number.
Numbers must be typed directly without pressing the spacebar. A numeric value can contain any of the

following:
0 1 2 3 4 5 6 7 8 9 + -

( ) / $ %

by default, numeric values are right aligned.

(¢) Formulae : Formula establish relationship between two or more cells. It performs a mathematical or
arithmetical operation on these data values such as :
Addition, subtraction, multiplication, division, etc. The formula entry can be made by beginning the
entry witha+, or=sign.

eg. = AlxA2
O H9 -5 student - Microsoft Excel - = X
[t | Y =
Home | Insert  Pagelayout Formulas  Data  Review View @& - @ X
} =) & ([[canon -1 || (S| S (e WA B E 2
Pa; d{a |B i “A- A'} | il 1:’ Number Styles | Cells —;l ﬁ'
[ = T | T 20| [ 35 %
- 7B A || sl et || e | PO S |
Clipboard ™ Font . Alignment . Editing
[ SUM v (2 X o fi| =C5+D5 ¥

A B E D E  —— HE

‘Marksheet for the Month of April

2

3
4 Subject Marks1 [Marks2 |total 3
E Hindi 90, 45]=C5+D5

6 English 30 56 86

7 | Mathemetic 12 65 77

8 | Science 28 34 62

9] So Science 24 45 69

10

44> M| Sheetl, Sheet2 ~ Sheetd ~¥J 4 | |
Edit |
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Formatting Text

Formatting text means changing the alignment of text, font size, font type, etc.
The formatting toolbar looks like:

Calibri -l - [ == S
B ZU- AN EEEA
(B[S A || ee-]
Font i Alignment £
Fig 10.2

Changing Font Type

There are different ways with which you can change the font type of your text. By using formatting toolbar you

can do in the following way:

Step1: Selectthe cells whose font type has to be changed.
Step2: Click atthe down arrow present at Font type box and selects the desired
font type.
0a H9-> $ student - Microsoft Excel i — <
< \ Home I, Insert  Pagelayout  Formulas  Data  Review  View @ - = x
1 | [;lll v |!!!'§ % & -
I:at £ o = Styles | Cell S
ste r es ells
- J | cambria (Headings)EI | = -
P r—' y I : et
Clipboard r_a. Calibri (Body) L Editing
84 | AnFonts X
A | pgency B || _F G fa
2 | % Aharoni 111 1T1aN
3 T ALGERIAN _ 1
E Eg_‘ Andaluz 3o :.Ni i 1
S5 | < P
= v angsana New Adan E
Fig 10.3
Changing Font Size

In the same way you can change the font size of your cell contents. Follow the steps given below:

Setp1:

Step2:

Select the text whose font size has to be changed.

Select the appropriate font size from the Formatting Toolbar.
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Making Cell Contents Bold, Italics or Underlined

You can enhance the look of your worksheet by showing the title and sub-titles in Bold, Italics or Underlined.
Follow the steps given below:

Step 1: Select the text.

Step 2 : Selectthe B button from the Formatting Toolbar to show the text in Bold.
Setting the Alignment of the Text

Alignment of the text places the text neatly within margins of the cell. We know, the text is left aligned by default.
The numbers are right aligned by default. We can also change the alignment of the text by following the steps
given below:

Step 1: Selectthe cell or cell range thathas to be aligned.

Step 2 : Select the 'Center alignment' button to place the text in the center of the cells.

Printing a workbook

Excel offers a very easy way of printing the workbook. You can very well control the overall look of the whole
printout and modify it to suit your own special requirements. You can preview your work before taking the final
printout. It will give the over all look of how your printout is actually going to look on paper. So, for previewing
the workbook, activate the 'Print Preview' option of the 'File' menu. Now, after previewing the workbook, you
areready to take a printout. So, proceed with the steps given below:

Step 1: Open the file whose printout has to be taken.
Step2: From the 'File' menu, select the "Print' option. A 'Print' dialog box appears on

the screen.
Print [ % |

Printer

Name: § Microsoft Office Document Image Writer E]
Status: Idle )

Type: Microsoft Office Document Image Writer Driver
Where:  Microsoft Document Imaging Writer Port:

Comment: —

[ Print to file

Print range Copies

@ al Number of copies: ||

") Page(s) From: | To: 5
Print what jﬂ ﬂ;l [@] Collate

Selection Entire workbook
@ Active sheet(s) Table

[ 1gnore print areas

o0 o) rg 0
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Step3: Choose the printer that you want to use out of all the installed printers on your
system from the '"Name' drop down list.

Step4: Youcanselect the pages of the workbook you want to print through the 'Print
range' option of the 'Print' dialog box. For example, if you want to take a
printout of all the pages of the current workbook, then click at the 'All' radio
button. But sometimes, you require only selective pages to be printed. For that
matter, click at the 'Pages' radio button and type in the starting number of the
page in the 'From'box. Similarly, enter the page number till which the printout
has to be taken in the "To' box.

Step5:  Enter the number of copies you want to print in the Number of Copies' box.

Step6: The'Print What' option lets you to decide in printing, either the selected portion
of'the worksheet or the whole workbook or just the active sheet(s).

Step7: Youcanalso see the preview of the workbook by clicking at the' Preview'
button.

Step8:  Finally, click the OK button.

Exercise
Fillin the blanks :
It allows to type in values and formula from the
Text value text, number or any special character.
Formula establish between two or more cells.

text means changing the alignment of text, font size, font type etc.

© a0 o

of the text places the text neatly within margins of the cell.

Write True or False in front of the following:

a Formula can be entered in a worksheet.

b We can center align the contents of a cell.

c. You cannot increase font size of text in EXCEL.
d A formula begins a +, = or @ sign.

e. You can take a printout of the selected cells also.
Answer the following questions :

a. Whatare the different data types offered by Excel?
b Write steps to change font type?

c. Write steps to set the alignment of the text.

d Write steps to print a workbook.
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CHAPTER 11
INTERNET-AN INTRODUCTION

You have heard a lot about the Internet. But do you know what it is? What are its uses and how you can use it?

Simply speaking, Internet is a computer network. A computer network is made by connecting two or more
computers through a cable. The computers which are connected to each other can share data, information and
resources. For example, a user on one computer can read a file from the disk of another computer connected to it
in the network.

To sum up we can say that a network is a collection of interconnected computers and devices. Internet is a
network of networks. It is a global network of computers connected to each other through high-speed links.

Fig 11.1

These networks are connected to smaller networks, which in turn are connected to still smaller networks, and
ultimately to individual computers belonging to individuals, businesses and institutions spread throughout the
world.

In this networked environment information on any computer connected to the network can be accessed by an
individual through another computer connected to the network.
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Internet is a convenient way to get information from all over the world. Internet is not owned by any individual,
company, business or government. It is just an interconnection of computers worldwide belonging to different
people.

Some of the most popular activities on Internet are sending and receiving e-mails, reading messages in
Newsgroups and browsing the World Wide Web(WWW) for information.

USES OF THE INTERNET
The Internet is widely used in almost every field. Some of the uses of the Internet are:
» Toprovide information, photographs, audio or video
To access information
To sent messages to and receive messages from other connected users
To converse with people in chat rooms

To get the latest news

YV V. V V V

To perform banking or business transactions

SERVICE AVAILABLE ON THE INTERNET

To support the above mentioned activities and many more, the Internet provides a variety of services.

ELECTRONIC MAIL

Electronic mail, commonly known as E-mail, is one of the most popular services on the Internet. It has become
an important means of communication for personal and business use.

E-mail allows you to sent and receive messages instantly with the help of computers when they are connected to
the Internet. Itis a cheap, fast and reliable method.

Fig 11.2



Advantages of E-Mail

Speed : Messages can be sent to any person anywhere in the world in a few
seconds or minutes.
Cost : Itis very cheap mode of communication. You pay only the cost of the

telephone bill for the period the connection is made.
Content : Any type or extent of information can be sent, i.e., text, graphics, video or

audio.

CHAT

Chat is a way of communicating with people over the Internet in real time. You can type a message which is
received by a connected computer user within seconds. Then the receiver can read the message instantly and
reply back by typing from the keyboard of his computer and you can read his/her reply on your computer within
seconds. This way you can communicate instantly with people around the world by typing back and forth. This is
called Chatting. It appears as if you are chatting with a person across the table. Chatting is a very popular feature
of the Internet.

FTP

FTP( File Transfer Protocol) allows you to exchange files with others on the Internet. An FTP server allows to
upload and download files using FTP.

WWW (WORLD WIDE WEB)

The most popular service provided by the Internet is World Wide Web popularly known as WWW. World Wide
Web has a vast collection of information on various topics, like education, entertainment, science, weather and
much more in the form of Web Sites.

WHAT YOUNEED TO CONNECTTO THE INTERNET

To get connected to the Internet you essentially need the following:
» Acomputer with atleast |GB RAM
» Atelephone connection
» Amodem
» AnInternet browsing software

» AnlInternet Service Provider (ISP) connection
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Fig 11.3

MODEM

A Modem is a device, which connects a personal computer to the Internet using a telephone line. It converts
digital signals to analog signals which is known as modulation and analog signals to digital signals called
demodulation. Hence, the name Modem is combination of modulation and demodulation.

Internet Browsing Software

An Internet browsing software, commonly known as a Browser, is a software which allows you to access and
browse through the information on the net. A browser is a must to access the Internet. Internet explorer and
Netscape Navigator are examples of commonly used browsers. If your PC has Windows as the operating system,
Internet Explorer would be automatically available on your system.

Internet Service Provider (ISP)

Internet Service Providers, popularly known as ISPs, are agencies that have installed very powerful computers
called Servers. Servers are connected to the Internet networks though satellite or other high-speed
communication channels. Some popular service providers in India are BSNL, MTNL, Satyam Online, Mantra
Online, Dishnet etc. These agencies provide Internet connections to the computer users. The ISPs give you an
account number called the User Name and a Password which is kept secret and belongs only to you.

When you want to use the Internet, you dial and get connected to your ISP. The ISP then handles all the data
communication between your computer and the Internet.
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STEPS TO CONNECT TO THE INTERNET

After ensuring that you have all the above-mentioned essentials, follow the steps given below to connect to the
Internet.

> Double-click on the Mobile Partner icon on the desktop for USB Modem

® Mobile Partner

File Operation Tools QuickLink Help

@ Connection ' Statistics e Call e Text % MMS E Phonebook _Q‘ Call Log

Profile Name:

Tata Docomo =
Idea

Videocon

Vodafone

Reliance Smart GSM 3G

Uninor »

Fig 11.4

> Select the ISP and click on the Connect button

Once the ISP's server has verified your User name and Password, a connection is established and an icon
appears in the right corner of your taskbar.

OR

Click on the icon of Broadband on the Desktop configured by various ISPs with the
help instructor in the lab session.

(=)



Exercise

Fillin the blanks.

doo isused to convert digital signals to analog signals.
e. Demodulation is the process of converting................... (0 R
f. Internet Explorerisa...........................
g. www.yahoo.comisa.............c.oovvenennn..

ho allows computer users to have face to face communication.

State True or False.

a. Chatisused to send messages through computers

b. Internetis a global network of computers

c. Internet Explorerisabrowsing software

d. ABrowser gives us an account number called the
User name and a password

Jiois not an Internet Service Provider

@

Answer the following questions.

a. Whatdo youunderstand by Internet?

b. Discuss some important uses of the Internet. List the various services provided by Internet.
c. Write ashortnote on e-mail.

d. Whatdoes FTP stand for?

e. WhatisaMODEM?

f.  Write down the steps to connect to the Internet.

g. Name any two Web Browsers.
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CHAPTER 12

MULTIMEDIA-AN INTRODUCTION

Multimedia

It is a combination of text, graphics, sound, animation, and video elements. All present day Pc's are multimedia

computers.

Examples : Some examples of multimedia are

>
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Internet applications.

Computer games.

Video or animation movies.

Computer based teaching (CBT) programs.

Advertisement films.

Hardware for multimedia usually consists of the following components :

>

Y

CD-ROM (Compact Disk Read Only Memory). It can hold up to one and a half hour audio or around
forty to fifty minutes of video.

DVD-ROM (Digital Video Disk Read Only Memory). It can store around 5 GB of data and transferring
data at higher speed.

Sound Card, Speakers, Microphone. They are required to record and produce sound.
Video Capture Card. itisused to capture TV or VCR or Camera images and store them into the computer.

Digital camera. It is a device, which captures and stores real pictures or Videos into memory of
multimedia PC.

Playing Video or movie CD in Windows

You can play an audio or video CD by following steps given below:

>
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First, click at Start button, and then type the windows media option.

Then windows media player will display on the screen.

Now Windows media player appears on the screen.

Now click the play button from the player windows.

Select the needed files or folders for play.

In this dialog box you can specify location of movie/song file and click at OK button.

You can also play audio CDs from by invoking CD Player in Entertainment option.
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] Megis P

8%, Windows Anytime Upgrade

) Windows Easy Transfer
Control Panel (62)

W Vindows Firewall
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B Windows CardSpace
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Files (5)

&) Get Windows Live

B Windows Live Gallery

] Windows Live Mail

B Windows Live Spaces

J2 see more results

|mndc¢4 %] | Shutdown |» |
3 S | o |1
Fig 12.1
Exercise
Fillin the blanks :
a Computerisa device.
b Multimediaisa oftext, graphics, sound, animation and video element.
C. can hold up to on and a half hour audio or around forty to fifty minutes of video.
d DVD-ROM can store around SGB of data and data athigher seed.
e are required to record and produce sound.

State ture of false :

a Multimedia is not combination of text graphics, sound and video.
b Full form of CD-ROM is compact disk read only memory.

C. Digital camera takes real pictures.

d Video capture card is used to captures TV or camera images.

e. Computer game is a example of multimedia.

Match the following :

a. Speakers Pictures

b. Digital Camera Sound

c. CD Digital Video Disk

d. DVD Compact disk

Answer the following questions.

a. What is multimedia? Give some examples.

b What are the multimedia hardware components?
C. Whatis Digital Camera?

d. Write full form of DVD-ROM.

e Write steps to play amovie CD.

(es)



CHAPTER 13
NUMBER SYSTEM

Computer is a electronic device that performs arithmetic operations, in digital system like computers the
quantities are represented by symbols called digits. Many number systems are used in digital technology that
represents the digits in various forms.

The most common are the decimal, binary, octal and hexadecimal systems.

Digital number system
In digital representation most common number systems are as following;

Decimal number system
Binary number system

Octal number system
Hexadecimal number system

el

1. Decimal number system

Decimal number system is composed of 10 numerals or symbols that's why this number system is called
decimal number system. These 10 symbols are 0,1,2,3,4,5,6,7,8,9 and base of this number system is 10.

DECIMAL NUMBER SYSTEM--—- RANGE-(0-9) AND BASE (10).

Example -
1. (3421),,
2. (10101),,
3. (65498),,
4. (32546),
2. Binary number system

In the binary number system there are only two symbols or possible digit values, 0 and 1. Even so, this base-2
system can be used to represent any quantity that can be represented in decimal or other number systems.

BINARY NUMBER SYSTEM---- RANGE-(0-1) AND BASE(2).

Example -
1. (101010),
2. (10011),
3. (01001),
4. (10111),

(=)



3. Octal number system

Octal number system is composed of 8 numerals or symbols that's why this number system is called octal
number system. These 8 symbols are 0,1,2,3,4,5,6,7 and base of this number system is 8.

OCTAL NUMBER SYSTEM---- RANGE-(0-7) AND BASE (8).

Example -
1. (3427),
2. (56326),
3. (65423),
4. (3254),

4- Hexadecimal number system

Hexadecimal number system is composed of 16 numerals or symbols that are why this number system is called
hexadecimal number system. These symbols are 0,1,2,3,4,5,6,7,8,9 and letters A,B,C,D,E,F. Base of this
number systemis 16.

HEXADECIMAL NUMBER SYSTEM---- RANGE-[(0-9), A,B,C,D,E,F] AND BASE (16).

Example -
1 (123549),,
2.  (ABCDEF),,
3.  (265DF),
4. (BACDF),

NOTE- ANY NUMBER SYSTEM CAN BE RECOGNISED BY ITS BASE.
Number conversion
Decimal number system recognize by universe i.e. we use decimal number system in our daily life for
representing quantities but computer cannot understand the decimal number system.
To make this decimal number system understandable for computer we convert decimal number system into

binary number system.

Decimal to Binary conversion

Method of converting decimal to binary is repeated —division method. In this method , the number is
successively divided by 2 and its remainders recorded .the final binary result is obtained by assembling all

<)

the remainders in reverse order .



Example-1
Convert 18,, to binary by using repeated division method.

Solution-

8

Write result in this order now your result is 10010
18,,.10010,

[\O NI \O R \O R O
o o= O

1
9
4
2
1

Example-2
Convert 33, to binary by using repeated division method.

Solution- 2133
6

A

Write result in this order now your result is 100001
33,,.100001,

[\ONE \O R \ORES
SO |OoC IO

1
8
4
2
1

Example-3
Convert  (53),, (?), .

Solution-

Write result in this order now your result is 110101
53, 110101,

(\O NI \ORE O RE SR O]
(OS]
—_— OO | = (OO |

v

Binary to Decimal conversion

Any binary number can be converted to its decimal equivalent simply by adding weight of every position in the
binary number that is every bit of binary number write with multiplication of 2 with power from 0 to next
number (power started from left to right of bit stream).

(=)



Example-1

Convert (1011) , binary number to it equivalent decimal number.

Solution :

Stepl :  Add multiplication of every bit from 2 .
Or
Add every bit after multiply it from 2.
1x2+0 x 2+1 x2+1x2

Step2 :  Raise power 0 to next number from left to right on every 2
1x2°+0 x 2°+1x2'+1x2°

Step3 :  Solve the powers and multiply with their bits
8+0+2+1

Step4: (11),

Example-2

Convert (110010), binary number to it equivalent decimal number.

Solution :

1x2+1x2+0x24+0x2+1 x2'+0x 2’
1x32+1x16+0x 8+0 x 4+1x2+0x 1
32+16+0+0+2+0

(50),

Example-3
Convert (100011) (?),

Solution-

1 x240x2+0x2+0x 2 +1 x2'+1 x 2°
1x32+0x 16 +0x 8+0 x 4+1x2+1x 1

32+0+0+0+2+1

(35)s,

(e0)



Exercise

1- Fill in the blanks.

a Octal number systemhaves .................. numerals or symbols.

b. numbers are used in daily life of human being.

b Base ofhexadecimal number systemis ............c..coevevieninaen..

c. Range of decimal number systemis.................. [£0 U

d. Base of decimal number systemis ...........coooeiiiiiiiiiniieeannnnn.
2- State True or False.

a. (1010),,1s an example of decimal number system.

b. Binary of (7),,is equivalentto (111),

c. Base of octal number system s 9.
d. Range of decimal number systemis from 0 to 9.
3- Match the column I and column I1
Column I Column II
a. (110101), Hexadecimal number
b. (AB65),, Binary number
c. (3452),, Octal number
d. (1276), Decimal number
e 2 Base of decimal number
f. 8 Base of hexadecimal number
g. 16 Base of octal number
h 10 Base of binary number
4- Solve the following
a. (1110), (Mo
b. (110011), (Mo
c. (111),, (7),
d. 27), (?),
e. (77)16 (7,
5- Answer the following questions

(a) What do you understand by number system?
(b) Discuss difference between octal number system and hexadecimal number system?
(©) Write a short note on binary number system?

(d) Write down two- two examples of binary, octal, hexadecimal number system?

()



Microsoft Word Shortcut Keys

Shortcut

Ctri+0
Ctri+ A
Ctrl +B
Ctrl + C
Ctri+D

Ctrl + E

Ctrl +F

Ctrl +1

Ctrl +)

Ctrl + K

Ctrl +L

Ctrl+ M
Ctrl+P

Ctrl +R
Ctrl+T

Ctrl+ U
Ctrl+V

Ctrl + X
Ctrl+Y
Ctrl+2

Ctrl + Shift + L
Ctrl + Shift + F

Ctrl + Shift + >

Ctrl +]
Ctrl + Shift + <

Description

Adds or removes 6pts of spacing before a paragraph.
Select all contents of the page.

Bold highlighted selection.

Copy selected text.

Open the font preferences window.

Aligns the line or selected text to the center of the
screen.

Open find box.

Italic highlighted selection.

Aligns the selected text or line to justify the screen.
Insert link.

Aligns the line or selected text to the left of the screen.
Indent the paragraph.

Open the print window.

Aligns the line or selected text to the right of the screen
Create a hanging indent.

Underline highlighted selection.

Paste.

Cut selected text.

Redo the last action performed.

Undo last action.

Quickly create a bullet point.

Change the font.

Increase selected font +1pts up to 12pt and then
increases font +2pts.

Increase selected font +1pts.
Decrease selected font -1pts if 12pt or lower, if above 1
decreases font by +2pt.

()



Microsoft Excel Shortcut Keys

Shortcut

F2
F3

F4

F5

F7

F11

Ctrl + Shift +;
Ctrl +;

Alt + Shift + F1

Alt + Enter

Shift + F3
Shift + F5
Ctrl+ A

Ctrl +B

Ctrl +1

Ctrl + K
Ctrl+U
Ctrl+1
Ctrl+5
Ctrl+P

Ctrl +2

Ctrl + F3

Ctrl + F9

Ctrl + F10

Ctrl + F6

Ctrl + Page up
Ctrl + Page down

92

Description

Edit the selected cell.
After a name has been created F3 will paste names.

Repeat last action. For example, if you changed the color of text in
another cell pressing F4 will change the text in cell to the same color.

Go to a specific cell. For example, C6.
Spell check selected text or document.
Create chart from selected data.

Enter the current time.

Enter the current date.

Insert New Worksheet.

While typing text in a cell pressing Alt + Enter will move to the next
line allowing for multiple lines of text in one cell.

Open the Excel formula window.

Bring up search box.

Select all contents of the worksheet.

Bold highlighted selection.

Italic highlighted selection.

Insert link.

Underline highlighted selection.

Change the format of selected cells.

Strikethrough highlighted selection.

Bring up the print dialog box to begin printing.

Undo last action.

Open Excel Name Manager.

Minimize current window.

Maximize currently selected window.

Switch between open workbooks or windows.

Move between Excel work sheets in the same Excel document.
Move between Excel work sheets in the same Excel document.
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